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Introduction

SmartFusion®2 system-on-chip (SoC) field programmable gate array (FPGA) devices integrate a fourth
generation flash-based FPGA fabric and an ARM® Cortex™-M3 processor, along with high performance
communication interfaces on a single chip. The SmartFusion2 high speed serial interface (SERDESIF)
provides a fully hardened PCle endpoint (EP) implementation and is compliant with PCle Base
Specification Revision 2.0 and 1.1. For more details, refer to the SmartFusion2 SoC FPGA High Speed

Serial Interfaces User’s Guide.

The demo explains the SmartFusion2 embedded PCI Express feature and‘how this can be used as a low
bandwidth control plane interface using the SmartFusion2 Development Kit. The demo provides a simple
design to access the SmartFusion2 PCle EP from a Host PC. A GUI is provided for read and write
access to the SmartFusion2 PCle configuration space and memory space of BARO and BAR1. The
demo also provides Host PC device drivers for the SmartFusion2 PCle EP. This demo can run on both

windows and Red Hat Linux operating system.

Figure 1 shows the top-level block diagram for the PCle control plane.demo. The demo design uses a
SmartFusion2 PCle interface with a maximum link width of x4 to interface with a Host PC PCle Gen2
slot. The SmartFusion2 microcontroller subsystem (MSS).GPIOs control the LEDs and switches on the
SmartFusion2 Development Kit through the PCle. interface. The Host PC can also read memory and
writes to the SmartFusion2 eSRAM through the GUI. The Host PC can also be interrupted by using the

push button on the SmartFusion2 Development Kit:

Host PC SmartFusion2

GPIO

ii

LEDs

Switches

GUI Root Complex(x4) “' PCle Endpoint (x4)

| Push
Button

eSRAM

Figure 1.¢ PCle Control Plane Demo Top-Level Block Diagram

The demo design performs the tasks listed below:
» Displays the PCle link enable/disable, negotiated link width, and the link speed.

» _Controls the status of LEDs on SmartFusion2 Development Kit according to the command from

the GUI.
» Displays the position of DIP Switches on SmartFusion2 Development Kit.
+ Enables read and writes to eSRAM.

» Interrupts the Host PC, when the push button is pressed. The GUI displays the count value of the

number of interrupts sent from the SmartFusion2 Development Kit.
» Displays the SmartFusion2 PCle Configuration Space.
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Demo Requirements

Hardware and Software Requirements

The hardware and software required to run the demo are listed in Table 1.

Table 1+ Required Hardware and Software to Run the Demo

Hardware

Version

SmartFusion2 Development Kit

Rev C or later’

12 V adapter (provided along with the kit)

FlashPro4 programmer (provided along with the kit)

PCI Edge Card Ribbon Cable (provided along with the kit)

Host PC with an available PCle 2.0 Gen1 or Gen2 compliant slot

Operating system:
Windows XP SP2: 64-bit

Windows 7: 64-bit
or
Red Hat Linux Kernel Version: 2.6.18-308

Software
Libero® System-on-Chip (SoC) vil4
SoftConsole v3.4SP1

Host PC Drivers (provided along with the design files)

GUI executable (provided along with the design files)

Note: The SmartFusion2 Development Kit has a label to specify the version.

Design Files

The design files for this demo can be downloaded from the Microsemi website:
http://soc.microsemi.com/download/rsc/?f=M2S_PCIE_Control DEMQO_11p4_DF

Design files include:

1. Libero project
Linux_64bit
ProgrammingFile
Windows_64bit
Source files
6. Readme file

o B own

Refer to the Readme.txt file provided in the design files for the complete directory structure.
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Demo Design Description

This demo design implements the SmartFusion2 embedded PCI Express interface as a low bandwidth
control plane interface. This design provides Host PC drivers and a Host PC interface over PCle to
control the SmartFusion2 device. Figure 2 on page 5 shows a detailed block diagram of the design
implementation. The PCle EP device receives commands from the Host PC through the GUI and does
corresponding memory writes to the SmartFusion2 MSS address space. The MSS address space
provides a GPIO block and eSRAM memory block which is accessed through a Fabric Interface
Controller (FIC_0).

The SERDES_IF_1 is configured for a PCle 2.0, x4 link width with GEN2 speed. The PCle interface to
the fabric uses an AMBA High-speed Bus (AHB). The AHB master interface of SERDESIF is enabled
and connected to the AHB slave interface of FIC_0 to access the MSS peripherals. The SmartFusion2
PCle BARO and BAR1 are configured in 32-bit memory mapped memory mode.

The AXI master windows of the SERDESIF PCle provide address translation for accessing one address
space from another address space as the PCle address is different from SmartFusion2 AHB bus matrix
address space. The AXI master window 0 is enabled and configured to translate the. BARO memory
address space to the MSS GPIO address space to control the MSS GPIOs. The AXI master window 1 is
enabled and configured to translate the BAR1 memory address<space to the eSRAM address space to
perform read and writes from PCle.

MSS GPIO block is enabled and configured as below:
* GPIO_0to GPIO_7 as outputs and connected to LEDs
* GPIO_8 to GPIO_11 as inputs and connected to DIP. switches

The PCle interrupt line is connected to the SW3 push button on the SmartFusion2 Development Kit. The
FPGA clocks are configured to run the FPGA fabric and MSS at 100 MHz.

- |EDs

Switches

eSRAM APB_1 |- GPIO

AHB Bus Matrix

FIC.0
MSS

Push
+PCIe_Interru pt Button

Serial Controller
Host PC < o010 4) GEN 2)

SmartFusion2

Figure 2 » PCle Control Plane Demo Block Diagram
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Building the Demo

This demo design provides a complete design flow starting from a new project to a working design on the
SmartFusion2 Development Kit. This process includes usage of the tools in the Libero SoC design suite
to program a SmartFusion2 device.

Building the demo involves the following steps:
« Step 1: Creating a Libero SoC Project
+ Step 2: Creating an eNVM Client
» Step 3: Developing the Simulation Stimulus
« Step 4: Simulating the Design
+ Step 5: Generating the Program File

Step 1: Creating a Libero SoC Project

1. Click Start > Programs > Microsemi Libero SoC v11.4 > Libero SoC v11.4, or click the shortcut
on your desktop. The Libero SoC v11.4 Project Manager is displayed asshown in Figure 3.

& Libero [ m——))

Project  File Edit View Design Tools Help

D w9 0B

N startpage =

-

e oI
Recent Projects = L I be @\

System-on-Chip

m

C:/Users/srikanth.a.../PCIE_Dema
C:/Users/srikanth.a.../PCIE_Demao

D:/11.4 UPLOAd/BFM/.../PCIE D || H A H

BT tpioadins —rar e on | VVE€lcOme To.Microsemi's Libero SoC

A

Software
Welcome to Libero SoC o

" Libero SoC is a comprehensive software suite for designing with Microsemi's SmartFusion2 and
Libero SoC Quickstart

SmartFusion SoC FPGAs, and |GLOO2, IGLOO, ProASIC3 and Fusion FPGA families.

Libero SoC Interface Description

1

Visit the Documents tab on your device page at www microsemi.com to obtain silicon Datasheets,

Libero SoC Release Notes on the Web Silicon User's Guides, Tutorials and Application Notes.

Lib Tut I . . . . .
ibero Iutorals Development Kits and Starter Kits are available from the Microsemi website.

Product Tutorials

1

What's Mew in | iharn SoC

Log & x

€3 Errars i Warnings @0 Info

Fam: |[Die: [Pkg:

Figure 3+ Libero SoC v 11.4 Project Manager

2. Create a new project by selecting New on the Start Page tab (highlighted in Figure 3), or by
clicking Project > New Project from the Libero SoC menu. Enter the information as required for
the new project and the Device in the New Project dialog box as shown in Figure 4 on page 7.

— Project Name: PCIE_Demo

— Project Location: Select an appropriate location (for example, D:/Microsemi_prj)
— Preferred HDL type: Verilog or VHDL

— Family: SmartFusion2

— Die: M2S050T

— Package: 896 FBGA

— Speed: -1

— Core Voltage: 1.2

— Operating conditions: COM
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3. Select Use Design Tool and Use System Builder in the Design Templates and Creators section
of the New Project window as shown in Figure 4.

rG\ Mew Project @

Project

[ Enable Block Creation

Mame: PCIE_Demo
Location: D Microsemi_prj
Prefered HOL type: @ werilog () YHOL
Description:
f
Device
I Family: SmartFusion2
Die: M25050T -

Package: 896 FEGA -

Speed: -1 -

Core Voltage (v): i - Ramp Rate:

Operating Conditions:

m

Range Best Typical Worst

23

o
[0
—

I Junction Temperature (C) [COM - l 0

t Core Voltage (V) [CDM w7 l 1,280 14200 1,140

[ System Controller Suspend Mode

4

PLL Supply Yoltage (V): 2.5

Design Templates and Creators

UUse Design Tool

Core ‘iersion

System Builder
SmartFusion2 Microcontroller Subsystem (MS5) 1.1.100

Shaw only latest version -

Help ’ QK ] [ Cancel

Figure 4 * Libero SoC v 11.4 New Project Dialog Box
4. Clicking Edit Tool Profiles displays the Tool Profiles window as shown in Figure 5. Check the
below tool settings:
— Software IDE: SoftConsole
— Synthesis: Synplify Pro ME 12013.09M SP1-1
— Simulation: ModelSim 10.3a
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— Programming: FlashPro 11.4

e I ==
‘ T00|;0&warEIDE Software IDE profiles

Synthesis
Simulation
Stimulus ) & softConscle edipse.exe
Programming
Identify Debugger

Active Name

Export Profiles... ] [

Figure 5  Tool Profiles

5. Click OK on the Tool Profiles window and click OK on the New Project window.

6. Selecting the Use System Builder displays the “Enter'a name for your system” dialog box, as
shown in Figure 6.

B Systemn Builder &lﬂ

Enter a name for your system:

PCle_Demo
Lo ][ oo
_— e —— E— — E——

Figure 6 * Create New System Builder Dialog Box

7. Enter PCle_Demo as the name of the system and click OK. The System Builder dialog box is
displayed with the Device Features page open by default.

8. Enter the following details in the System Builder — Device Features page as shown in Figure 7
onpage 9:
— Memory; Clear all except MSS On-chip Flash Memory (eNVM)
= High-speed serial interfaces: Check SERDESIF_1
— ' Microcontroller Options: Clear All
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[ o ST e e P — - BTN
> Device Features Memories » » Peripherals » } Clocks Microcontroller » 7 SECDED » } Security > Interrupts » > Memory Map »

Select the SmartFusion2 features you will be using in your design

Memory

[] M55 External Memory

(@ MDDR
Saft Memary Contraller (SMC)
MSS On-chip Flash Memary { eNvM )
[] Fabric External DDR Memary ( FDDR )

High Speed Serial Interfaces

[] SERDESIF_D
SERDESIF_1

Microcontroller Options
[F] wiatchdog Timer
[] Peripheral DMA
[7] Real Time Counter

W LZE3ucTE Eav wOOi

FAR_COD

A0S HODN
0915 Eav waoiy

i
1
1
i
i
1
1
|
i
i
1
1
i
i
1
1
i
i
i
1
i
i
i
i
H
i
i
i
H
i
i
i
i
1

SDR 2 E=

RAM & CCRESDR
i
i
H

T = (e |

Figure 7 » SmartFusion2 SoC FPGA System Builder Configurator
9. Click Next. The System Builder — Memories page is displayed.
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10. Click Next. The System Builder — Peripherals page is displayed. Drag the Fabric AMBA
Master to MSS_FIC_0 — Fabric Master Subsystem as shown in Figure 8. It enables the MSS
FIC_0 slave interface.

(® System Builder - Peripherals [EEE

> Device Features » > Memories » » Peripherals » ) Clocks Microcontroller SECDED Security » Interrupts » » Memory Map »

Select the peripherals and masters for each subsystem

Fabric Slave Cores Subsystems
Care Version [@ MSS FIC_0 - MSS Master Subsystem -
1 CoreAHBLSRAM 20113 I drag and drop here to add to subsystem
2| CorePI0 20120 ® M55 FIC 0 - Fabric Master Subsystern
g Corel2C 70102 Confiqure Quantity Name
4 CorePWM 41106 & T [AvBAASIER.
5 CoreSPl 30156
5| CoreTrmer 11101 @ MSS FIC_1 - MSS Master Subsystem
7 CoreUsRTapb 522 %I
8 Fabric AMBA Slave 0.0.102 @ MSS FIC 1 - Fabric Master Subsystern
I drag and drop here to add to subsystem
@ MSS Perpherals
Fabric Master Cores / (Configure Enable Name
] Core I Version V4 O |meaysrro
1| Fabric AMBA Master 00102 I O |sbiuarrs
O |mssmes
[0 |msspes
O |mssspe
O msssspre
I 1S5_GPIO
o [Fse-ose
[0 [ mssarec
I [mss_can
To move & penpheral from one subsystem to anathe; drag it fom its present focation and drop it onto the desied susbsystam.
You cannot drag and drop onto MSS Peripherals.
Masters are in bold and blue.
=

Figure 8 » System Builder Configurator —Peripherals Page

11. Disable the MSS Peripherals except MSS_GPIO. The System Builder — Peripherals page is
displayed as shown.in Figure 9.0n page 11. Configure MSS_FIC_0 — Fabric Master Subsystem
for AHB-Lite by clicking on the AMBA_MASTER_0 configurator button highlighted in Figure 9 on
page 11. This displays a drop-down list as shown in Figure 10 on page 11.
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(® System Builder - Peripherals e B [

Device Features Memories » » Peripherals » » Clocks Microcontroller SECDED Security »_Interrupts » > Memory Map »
Select the peripherals and masters for each subsystem

Fabric Slave Cores Subsystems
Core Version @ MSS FIC 0 - MSS Master Subsystem 1-

CoreAHBLSRAM 20113 I drag and drop here to add to subsystem
CereGPIO 30120 =
S @ MSS FIC 0 - Fabric Master Subsystern

Corel2C 70102 Configure Quantity Name

sy S & 1 |AMBA MASTER 0
CoreSPl 30156
CoreTimer 11100 MSS FIC_1 - M5S Master Subs)

drag and drop here to add to subsystem

CoreUARTapb 522

Fabric AMBA Slave 0.0.102 ] MSS FIC_1 - Fabric Master Subsystem
I drag and drop here to add to subsystem

] MSS Perjpherals
Fabric Master Cores Configure Enable Name

@ |~ o [t [ W e =

| Core I Version

1 Fabric AMBA Master 00102

(o | | | s | i | |

To move 3 peripheral from ane subsystem to another drag it from its present focation and drop it onto the desired susbsystem.
You cannot drag and drop onto MSS Peripherats.

Masters are in bold and blue.

Figure 9 » System Builder Configurator — Peripherals Page

12. Select AHBL.ite from the drop-down list as shown in Figure 10.

 Canfiguring AMBA_MA. [sculaEeliee S
—

Configuration

Interface Type

Help

Figure 10 « Configuring AMBA Master
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13. Configure MSS_GPIO by clicking MSS_GPIO Configure as shown in Figure 11.

(® System Builder - Peripherals B | S
Device Features Memories » » Peripherals » » Clocks Microcontroller SECDED Security »_Interrupts » > Memory Map »
Select the peripherals and masters for each subsystem
Fabric Slave Cores Subsystems
Care Version [@ MSS FIC 0 - MSS Master Subsystem I8
1 CoreAHBLSRAM 20113 I drag and drop here to add to subsystem
2 CoreGPIO 30120 _
i @ MSS FIC 0 - Fabric Master Subsystemn
G| CorelaC Ll Configure Quantity Name
4 CorePWM 41106 &F T | SERRSTER
5 CoreSPl 30156
e R MSS FIC 1 - MSS Master Subs)
e e 5 drag and drop here to add to subsystem
& Fabric AMBA Slave 0.0.102 ] MSS FIC 1 - Fabric Master Subsystem
I drag and drop here to add to subsystem
@ MSS Perppherals
Fabric Master Cores Configure Enable Name
| Core | Version MM_UARTO

1 Fabric AMBA Master 00102

(o | | | s | i | |

To move 2 perpheral from one subsystem fo another, drag it from its present location and drop it onto the desired susbsystem.
You cannot drag and drop onto MS Perpheras.

Masters are in bold and blue.

Figure 11 « System Builder — Peripherals Page

14. Double-click MSS_GPIO configuration button as shown in Figure 11 and configure:
— GPIO_0 to GPIO_7 as outputs and their connectivity to FABRIC_A to connect with LEDs
— GPIO_8 to GPIO_11 as inputs and their connectivity to FABRIC_A, to connect with DIP
switches

This design requires configuring GPIO_0 to GPIO_7 to drive LED 1 to LED 8 on the
SmartFusion2 Development Kit, and GPIO_8 to GPIO_11 to connect DIP1 to DIP4. These signals
will be routed through'the fabric to the I/O pins.
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Figure 12 shows the MSS GPIO Configurator.

i; i.MSSGP]D Configurator .

Configuration

Set/Reset Definition

Connectivity Preview

GPIO_31_24 Reset Source ISYSREG (MS5_GPIO_31_24 SOFT_RESET)

*]  ResetState 1 v

GPI0_23_16 Reset Source [SYSREG (MS5_GPIO_23_16_SOFT_RESET)

v]  ResetState [ 7]

GPIO_15 8 Reset Source [ SYSREG (MSS_GPIO_L5 8_SOFT_RESET)

v|  ResetState E]

GPIO_7_0Reset Source | SYSREG (MSS_GPIO_7_0_SOFT_RESET)

v|  ResetState E]

GPIO Assignment

GPIO ID Direction

Advanced Options

FABRIC_A —~
FABRIC_A ~
FABRIC A ~
FPGA Fabi
FABRIC_A ~
Clich a signal row to s
FABRIC_A —~
FABRIC_A ~
FABRIC A ~

preview

Figure 12 « GPIO Configuration
15. Click OK on MSS GP

Revision 3

13



& Microsemi

SmartFusion2 SoC FPGA - PCle Control Plane Demo

16. Click Next. The System Builder — Clock page is displayed, as shown in Figure 13. Change the
configuration of System Clock from 100 MHz to 50 MHz. The dedicated input pad will be
connected to on board 50 MHz oscillator. The M3_CLK is configured to 100 MHz by default.

.—@ System Builder - Clocks [EEE—)
> Device Features » > Memories » » Peripherals » ; Clocks » 2 Microcontroller » ) SECDED Security » Interrupts » » Memory Map »

Configure clock requirements

Clock | FabricccC | Chip Osllators

System Clock

E Mz

[Dedicated Input Pad - DOR Eridge
Cortex-M3 and MSS Main Clock

M3_aLK = 100.00 MHz 100,000

MDDR Clocks

MDDR_CLK =mzaks (1 -]

DDR/SMC_FIC_CLK =MDDR_CLK/ [T -

MSS APB_0/1 Clocks

APB_0_CLK —M3_CLK [ 100.000

APB_1_CLK =mz_clK / 100.000

Fabric Interface Clocks

FIC_0_CLK —M3_ClK/ 100,000 e

FIC_1_CLK -mzak/ (1 -+ CooRLL |

Fabric DDR Clocks —t

FDDR_CLK = 100 | Mz

FODR_SUBSYSTEM CLK ~ —FDDR_CLK/ [1 =

,,,,,,,,,, o S N I e )

—

Figure 13 « System Builder Configurator — Clock Page
17. Click Next. The System Builder - Microcontroller page is displayed. Leave all the default
selections.
18. Click Next: The System Builder - SECDED page is displayed. Leave all the default selections.
19. Click Next. The System Builder - Security page is displayed. Leave all the default selections.
20. Click Next. The System Builder - Interrupts page is displayed. Leave all the default selections.

21.Click Next. The System Builder - Memory Map page is displayed. Leave all the default
selections.

22.Click Finish.
The System Builder generates the system based on the selected options.
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The System Builder block is created and added to Libero SoC project automatically, as shown in

Figure 14.

Tools

Help

Project  File SmartDesign

MW o™

Design Flow

Edit View Design

PCle_Demo_top

® x| Startpage & X | Ercie Deme_top & X |

Bomr Ml Boro"r QARAE ANDO

Tool
4 » Create Design
& Systern Builder
& Configure MSS
B3 Create SmartDesign
Create HDL
24 Create SmartDesign Testbench
Create HDL Testbench
b Verify Pre-Synthesized Design
. Simulate
Create Constraints
+= /0 Constraints
O Timing Constraints
Q{ Floorplan Constraints
Implement Design
T Synthesize
b Verify Post-Synthesis Implementation
. Simulate
B Compile
«] Configure Flash*Freeze
25 Place and Route
4} Edit Constraints
+= 1/0 Constraints
0 Timing Constraints
Q Floorplan Constraints
4 b Verify Post Layout Implementation

[N

[N

[N

[N

>

B
=1
o
i}
i
2]
£
E\
= e
3 @
=
=
PCle_Demo_0
P FAB_RESET_N  POWER_ON_RESET_N[ 1
b CLKO_PAD SOIF_READY B
b DEVRST_N WSS_READY]
m D EISDIF1_PINS FIC_0_PINS [
FAB_CCC_PIN:

INT_APB

* SOIF1

GPIO_FABR
INIT_PINS

I Design Flow ‘ Design Hierarchy I Catalog | Files | HDL Templates

Log

€3 Errors 4, warnings i Info

The PCIE_Demo project was created.

Info: "PCIe_Demo MSS' was successfully generated.
Info: "PCIe_Demo' was successfully generated. L
Info: System Builder successfully generated 'PCIe_Demo®.  Cpen System Bulldes summary for details b
Info: PAD pin "PCIe_Demo_0:CLKO_PAD™ of “PCIe_Demo 0/ 1s automatically connécted to a top-level port.
Info: PAD pin "PCIe_Demo 0:DEVRST_N- of "PCIe_Demo 0 1s autbmatically connected to a top-level port. o
Log Cores
Fam: SmartFusion2 | Die: M25050T |Pkg: 896 FBGA | Verilog

Figure 14 « SmartFusion2 SoC FPGA System Builder Generated System

The two soft cores (CoreResetP and CoreConfigP) will be automatically instantiated and
connected by the System Builder. How these blocks are connected can be seen by opening the
System Builder component in the SmartDesign canvas.

Note:

CoreResetP and CoreConfigP are responsible for the reset and configuration of ASIC peripherals.

In this particular demo they are used to reset and configure the SERDESIF module. These modules
are included in the System Builder generated component when an ASIC peripheral is selected.

Revision 3

15



& Microsemi

SmartFusion2 SoC FPGA - PCle Control Plane Demo

Instantiating the SERDESIF Component in PCle_Demo_top

SmartDesign

The Libero SoC Catalog provides IP cores that can be easily dragged-and-dropped into the SmartDesign
Canvas workspace. Many of these IPs are free to use while several require a license agreement. The
SERDESIF module that supports the PCle embedded interface is included in the catalog. To instantiate
the SERDESIF component in the PCle_Demo_top SmartDesign, expand the Peripherals category in

the Libero SoC Catalog.

Catalog 5 x
IQ +  [] simulation Mode , A
Mame ’ Version i
CoreResetP 7.0.104
&= CoreSDLC 30121
&= CoreSDR 4.0115
&= CoreSDR_AXI 20116
&= CoreSPI 42116
&= CoreSysServices 2.0.102
&= Corelimer 11101
&= CoreUART 54.2
& CoreUARTapb 54.2 ~
[ Corg_Watchdoq 1.1.101 L.
:High Speed Serial Interface 1.2.102 y
> Processors
> SC/Tamper it
Documentation:
High Speed Serial Interface Configurator User's Guide
Description: High Speed Serial Interface
| Design ... | Design Hiera... I Sﬁalus Hiera... Catalog Files I HOL Templ...

Figure 15 « IP Catalog
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1. Drag the High Speed Serial Interface onto the PCle_Demo_top SmartDesign canvas. If the
component appears shadowed in the Vault, right-click the name and select Download.

2. Double-click the SERDES_IF_0 component in the SmartDesign canvas to open the SERDES
configurator. Configure the SERDES with the following settings as shown in Figure 16:

— Select SERDESIF_1

— Simulation Level: BFM PCle

— Protocol1: Number of Lanes: x4

— Protocol1: Type: PCle

— CLK_BASE Frequency (MHz): 100

— Lane Configuration: Speed: 5.0 Gbps(Gen2)

— Lane Configuration:

— Reference Clock Source: REFCLKO (Differential)

.| High Speed Serial Interface Configurator - ey
Identification
) SerDesIF 0 |® SerDestF 1 | ) SerDesIF 2 () SerDesIF_3 Simulation Ledel
Protocol Configuration
Protocol 1 Protocol 2
Type [PCIE '] [Conﬁgure PCle Type | None
Mumber of Lanes |x4 w Number of f&Res -1
Lane Configuration
Lane 0 Lane 1 Lane 2 Lane 3
Speed 5.0 Gbps(Gen2) v 50Gbps(Gen2) - 50 Gbps(Gen2) ~ 5.0 Gbps(Gen2) -
Reference Clock Source REFCLED (Differential) -
PHY RefClk Frequency ( MHz ) 100
Data Rate ( Mbps ) N/A, N/A N/A N/A
Data Width WA N/A N/A N/A
VCO Rate ( MHz ) Ny& N/A N/A N/A
FPGA Interface Frequency { MHz ) NSA MN/A NSA MN/A
PCle/XAUT Fabric SPLL Configuration
CLK_BASE Frequency! 100 MHz
o) o)

Figure 16 - SERDES Configurator
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3. Click Configure PCle in Protocol1 as shown in Figure 16 on page 17. Make following settings in
the Configuration tab as shown in Figure 17 on page 19.

Fabric Interface (AXI/AHBLite)

- Bus: select as AHBLite from the drop-down list

Base Address Registers

- BAR 0 Width: 32-bit, Size: 1 MB (to access MSS Peripheral address space)
- BAR 1 Width: 32-bit, Size: 64 KB (to access eSRAM memory)

Identification Registers

- Device ID: 0x11AA (MicroSemi ID)
- Subsystem Vendor ID: 0x11AA (MicroSemi ID)

18
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- —
5] PCIE Configuration for Protocol 1 - S s — - B

Configuration Master Interface Slave Interface |

Identification Registers

Vender ID Ox11AA Device 1D Ox11AA
Subsystem Vendor ID Ox11AA Subsystem Device ID Q0000
Reevision ID 0x0000 Class Code Ox0000

Fabric Interface (AXIfAHBLite)

Bus [AHBLite ~ Interface

Base Address Reqisters

Bar 0: Width [32Bits v | Sze [1MB v Prefetchabld

Bar 1: Width [32Bits ~| size [64KB v | |
Bar 2: Width |Maone - Size - Prefetchable

Bar 3: Width Size -

Bar 4: Width Size - A Pretetchable !
Bar 5: Width Size -]

Options

PHY Reference Clock Slot [FL2e2

PCle Specification Version Transmit Swing ]
Interrupts De-emphasis |[DB 3.5 -

O, ] [ Cancel

Figure 17 « PCle Configuration for Protocol 1
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4. Click the Master Interface tab to configure the PCle master windows. The PCle AXI master
windows are used to translate the PCle address domain to the local device address domain. In
this demo the PCle AXI master windows are used to translate the address of BARO and BAR1 to
CoreGPIO address and COREAHBLSRAM address. Make settings as shown in Figure 18.

— Select Window 0 and configure following settings:
- Size: Select as 1MB from the drop-down list
- PCle BAR: Select as Bar0 from the drop-down list
- Local Address: Enter values as 0x40000 to translate the BARO address space to CoreGPIO
address (0x4000_0000)
— Select Window 1 and configure following settings
- Size: Select as 64KB from the drop-down list
- PCle BAR: Select as Bar1 from the drop-down list
- Local Address: Enter values as 0x20000 to translate the BAR1 address space to
COREAHBLSRAM address (0x2000_0000)
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For more information on PCle address translation, refer to the "Address Translation on the AXI
Master Interface" section of the SmartFusion2 SoC FPGA High Speed Serial Interfaces User
Guide.

5| PCIE Configuration for Protocol 1 M

Master Interface Slave Interface

Window 0

Size [1m8 ~ | PCleBAR  [Bar0 -

Local Address  0x40000 PCIe Address  0x0000

Window 1

Size 54 KB = | PCle BAR Bar 1 -

Local Address  0x 20000 PCIe Address  0x0000

[ window 2

Size 4KB v |pcreBar  [Baro v_]

Local Address | 0x0000 PCle Address |0x0000 7

[] window 3

Size 4KB v|pcleBar  [Baro S -]
EE—— = 1

Local Address | 00000 PCIe Address |0x@00

oK ] [ Cancel

Figure 18 « PCle Configuration Memory

5. Click OK to close PCle Configuration window.
6. Click OK to save and close the High Speed Serial Interface Configurator.
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Instantiating Debounce Logic in PCle_Demo_top SmartDesign

1. The demo provides a push button on the SmartFusion2 Development Kit to send an interrupt to
the Host PC. This push button generates switch bounce that causes multiple interrupts to PCle.
Debounce logic is required to avoid the switch bounce.

2. To add the debounce logic to the PCle demo design, click File > Import > HDL Source files.

3. Browse to the Debounce.v or Debounce.vhd file location in the design files folder:
M2S_PCIE_Control_ DEMQ_DF/Source Files. Figure 19 shows the DEBOUNCE component in
the Design Hierarchy window.

Design Hierarchy @

srons 2
4 o@ wark

4 w PCle_Demo_top
SERDES_IF
4 w PCle_Demo
CoreAHBLite
CoreConfigP
CoreRezetP
Fccc
| 0sC

Figure 19 « DEBOUNCE Component in the Design Hierarchy Window
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4. Click the PCle_Demo_top tab and drag the DEBOUNCE component from the Design Hierarchy
into the PCle_Demo_top SmartDesign canvas as shown in Figure 20. A SmartDesign symbol
for the Verilog HDL file is automatically generated.

(@ Libero - DAMicrosemi_proj\PCIE Demo\PCIE Demo.prix” . 1 . | “— e )

Project File Edit View Design Tools SmartDesign Help

Design Herarchy 8 X [ Startpage & x | S PCIE Demo_top™ & X S
|usmtone 82, |

Show:

SH2ace@o0l &

[Componeni =] B (Bommppo B, QAU E A\ O
O vor

B XTLOSC_FAB (osc_comps)

DEBOUNCE_0

+ O pat ve ax NTERRUPT]
() Pcie er _”’/% RESET N
L DEBOUNCE (et BT

R (Ocbounce)
@ CorearBLITE B )
PCIE_Demo_0
DB ! RONF A,
L ®axm MSS_READY
T RST_N - 0]
st

o
3
J
£ 2
S
SERDES_IF_0 H
CORE RESET N POE SYSTEMLIT] 5
FHY RESET 1 AL L 2
APSS PRESETN PLL_LOCKLOST I
\CBASE =
APES POLK POE EV_1US
FOENTERRUPTI30] REFGLKO-OUT]
(S TG -------- @EPDs_N FADs_OUTE s
§
=
2
& @ ¢@w

O o e |
ax

Fom: SmartFusion2 |Die: M2S0SOT |Pho: 896 FBGA | Veriog

| T i Tt T .~ LT ST

Figure 20 - DEBOUNCE Component in Design Hierarchy

The PCle_Demo_top is displayed as shown in Figure 22 on page 25. Connect the pins of all the blocks
as described in the "Connecting Components in PCle_Demo_top SmartDesign" section.

Connecting Components in PCle_Demo_top SmartDesign

There are three methods for connecting components in PCle_Demo_top SmartDesign.

The first method is by using the Connection Mode option. To use this method, change the SmartDesign
to connection mode by clicking Connection Mode on the SmartDesign window, as shown in Figure 22
on page 25. The cursor changes from the normal arrow shape to the connection mode icon shape. To
make a connection.in this mode, click on the first pin and drag-drop to the second pin that you want to
connect.

The second method is by selecting the pins to be connected together and selecting Connect from the
context-menu. To select multiple pins to be connected together, press down the CTRL key while
selecting the pins. Right-click the input source signal and select Connect to connect all the signals
together. Similarly, select the input source signal, right-click it, and select Disconnect to disconnect the
signals already connected.

Revision 3 23



& Microsemi

SmartFusion2 SoC FPGA - PCle Control Plane Demo

The third method is by using the Quick Connect option. To use this method, change the SmartDesign to
quick connect mode by clicking on Quick Connect mode on the SmartDesign window, as shown in
Figure 21. Quick connect window will be opened.Find the Instance Pin you want to connect and click to
select it. In Pins to Connect, find the pin you wish to connect, right-click and choose Connect as shown in
Figure 21.

rG‘ QuickConnect l ? &1

Instance Pins Pins to Connect
[AII unconnected pins in design - ] Search: =** -
Enter 3 widcard search in the form of [Tnstance]. [Pin]
Pin Connection « | 4 DEBOUNCED i
[ PCle_Demo_0:POWER_ON_RESET_N B clk |
[E> INTERRUPT £
[ PCle_Demo_0:5DIF1_CORE_RESET_N B> RESET N 1
e_Demo_0:! | | |
[® Pcle_D: 0:SDIF1_PHY_RESET_N B swiTcH
B PCle_Demo_0:SDIFL_SPLL_LOCK 4 PCle_Demo 0
D W AMBA_MASTER_D
SERDES_IF_0:APB_S_PCLK B cLko_PaD
B> SERDES_IF (:APB_S_PRESET_N B DEVRST N

SERDES_IF_0:CLK_BASE — . FAB_RESET_N
[+ FIC_0_CLK

B> SERDES_IF 0:CORE_RESET_N i B FIC 0 LocK b Connect
[ SERDES_IF 0:PCIE BV 1US 1 B GPIO_O.M2F | |- Discorinect
B> SERDES_IF_0:PCIE_INTERRUPT[3:0] B> GP10_10_F2M
B> SERDES_IF 0:PCIE_INTERRUPT[3:1] B> GPio 11 F2M
B> SERDES_IF_0:PCIE_INTERRUPT[O B GPIO_1 M2F
= o - B GPIO_2 M2F 8

Right-dlick on pins fo perform connectivity Sctions.

Driver pins are blue.

k=

Figure 21 » Quick Connect Window
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Project File Edit View Design Tools SmartDesign Help

OEN 2N 0H

Design Hierarchy 5 %| [ startage & x | Epcie pemo_top* & x|

Gz E Beompo B, QARG E ANO

+ Ol work
[2L XTLOSC_FAB (0sc_compsiv)
Bl XTLOSC (osc_comps.)
Bl RCOSC_IMHZ_FAB (0sc_comps.v)
% RCOSC_IMHZ (us(;umpsv)p =
> €3] Pde_Demo_top
[ DEBOUNCE (Debounce.v)
> il COREAHBLITE_LIB

DEBOUNGE_O
e

=20

S

)

< m '

[ DesignFlon | Design Herarchy | Catelog | Fies | HDL Templates

Log

[[ElMessoges | @ Errors i, wamings @ 1nfo

®1nzo: 520 pin “FCTe Demo 0:CIKO_PAD' of “ECTe Demo 0° is eutomaticelly conmected to a top-level port
@10z £aD pin “PCTe_Demo_0:DEVRSI_N' of “ECTe_Demo 0° is automavically connected to a top-level port.

nfo: Group pin "SERDES_IF_0:BADs_IN' cannot be promoted because it has pins which are already grouped on the tep devel
@100 pap pin “SERDES_IT_0:PADs_IN' of 'SERDES_IF_0' is automatically connected to a top-level port.

Info: Group pin "SERDES_IF_0:EADs_Of
@10z paD pin “SERDES_IT_0:PADs_OUT' of “SERDES_IF_0° is automavically connected to a top-lével port.

cannot be promoted because it has pins which are already gromped on the top level

Fam: SmartFusion2 | Die: M2S050T | Pkg: 896 FBGA

Verlog

]

Figure 22 « PCle Demo Top in SmartDesign

Use one of the three options described above and make the following connections:
1. Expand FIC_0_PINS of PCle. Demo_0 and make connections as shown in Table 2.
2. Right-click FIC_0_LOCK and select mark unused

Table 2+ FIC_0_PINs

From PCle_Demo_0 To

CLK_BASE of SERDES_IF_0

FIC_0_CLK
CLK of DEBOUNCE_0

3. Expand SDIF1_PINS of PCle_Demo_0 and make connections as shown in Table 3.

Table 3 * SDIF1_PINS

From PCle_Demo_0 To SERDES_IF_0

SDIF1_PHY ‘RESET N PHY RESET N

SDIF1_CORE_RESET_N CORE_RESET_N

SDIF1_SPLL_LOCK SPLL_LOCK

4. Right-click SDIF1_PERST_N and select Promote to Top Level.
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5. Expand INIT_PINS of PCle_Demo_0 and make connections as shown in Table 4.

Table 4 « INIT_PINS

From PCle_Demo_0

To SERDES_IF_0

INIT_APB_S_PCLK

APB_S_PCLK

INIT_APB_S_PRESET N APB_S_PRESET N

®© N o

Right-click INIT_DONE and select mark unused.
Connect MSS_READY of PCle_Demo_0 and RESET_N of DEBOUNCE_0.
Right-click the FAB_RESET_N of PCle_Demo_0 and select Tie High.

9. Right-click the GPIO_FABRIC of PCle_Demo_0 and select Promote to Top Level.
10. Right-click POWER_ON_RESET_N of PCle_Demo_0 and select Mark Unused.

11. Right-click SDIF_READY of PCle_Demo_0 and select Mark Unused.

12. Connect AMBA_MASTER_0 of PCle_Demo_0 and AHB_MASTER of SERDES _IF_-0.
13. Expand FAB_CCC_PINS, right-click FAB_CCC_GL3 and.select Mark Unused.

14. Connect SDIF1_INIT_APB of PCle_Demo_0 and APB_SLAVE of SERDES_IF_0.

15. Right-click the SWITCH of DEBOUNCE_0 and select Promote to Top Level.

16. Select the below ports of SERDES_IF_0 by pressing down the CTRL key, right-click, and select
Mark Unused.

PCIE_SYSTEM_INT
PLL_LOCK_INT
PLL_LOCKLOST_INT
PCIE_EV_1US
REFCLKO_OUT

The PCle supports four interrupts. This design uses only one interrupt out of four by connecting the
unused interrupts to logic ‘0’. To connect unused interrupt pins to logic ‘0’ split the interrupt pins to two
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groups. To do that right-click the PCIE_INTERRUPT[3:0] of SERDES_IF_0 and select Edit Slice. The
Edit Slice window is displayed as shown in Figure 23.

7 Edit Slices - PCIE_INTERRUPT[3:0] .2 |ﬁ

Create slices of width [1 "’] [ Add Slices ]
x

PCIE_INTERRUPT[Z:0] [E» Left Right

o7 )

., - s B I 3 ..

Figure 23 + Edit Slices

17. Click the + sign and create a<slice with the Left index 0 and the Right index 0. Click + again to
create a second slice with Left index 3 and Right index 1 as shown in Figure 24.

r N
& Edit Slices - PCIEANTERRUPT[3:0] D |-
Create slices of width [1 '] l Add Slices l
X
Wl PCIE_INTERRUPT[3:0] [E» Left Right
1
2

ﬂ o) oo

Figure 24 + Edit Slices

18. Expand PCIE_INTERRUPT[3:0], right-click the PCIE_INTERRUPT[3:1], and select Tie low.
19. Connect INTERRUPT of DEBOUNCE_0 to the PCIE_INTERRUPT[0] of SERDES_IF_0.
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20.Click Auto arrange instances to arrange the instances and click File > Save. The
PCle_Demo_top is displayed as shown in Figure 25.

DEBOUNCE_0

SWITCH
PCle_Demo_0
4P FaB_RESET_N PCAWER_ON_RESET_N
CLFD_FAD) CLKD_PAD SOIF_READY
DEVRST N DBE/RST_N MSS_READY
[ SDIF1_FERST Ml EISDF1_FINS FIC_0_PNS[E]
SDF1_PERST_N FIC 0_CLK
SDF1_PHY_RESET_N FC_0_LOCK
SDF1_CORE RESET_N B CCC PNSEHE
SDF1_SALL_LOCK GFIO_FABRICE GHAD FABRIC
NIT_FNSE]
NIT_APB_S_PCLK
INIT_APB_S FRESET_M.
INIT_D@NE
Chl
i
=&
it
=
=
<L @ w
R
=
3k
w|§
o
S
<L
SERDES_IF_0
CORE RESET_N PCE_SYSTEM_INT
PHY_RESET_N
APB_S_PRESET_N PLL_LOCHLOST_INT
CLK_BASE

EIFCIE_INTERRUFT[2:0]

FCIE_INTERRUPT[2:1]
FCIE_INTERRUFTIC]
RDs_IN

p[HFADs OUT

Figure 25 « PCle Demo Top Design
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21. Click the PCle_Demo_top tab and click Generate Component icon as shown in Figure 26.

E PCIe_Demo_top ﬁ
|

= Generate Component ]

(|

Figure 26 » Generate Component

The message “PCle_Demo_top' was successfully generated” is displayed in the Libero SoC log
window if the design is generated without any error. The log window is displayed on a successful

component generation as shown in Figure 27

Design Flow | Design Hierarchy | Catalog | Files | HDL Templates | L

Log

&3 Errors 4, warnings i Info
Heading file '"Uebounce.v'. By Wb
Reading file "testbench.wv'.
®1nso: prosile 'Synplify Pro ME' activated.
eInfn: Profile "ModelSim ME' actiwvated.

e PCIE Demo projech was gpeped

Info: 'PCIe Demo top' was successfully generated.
Tting 'C:/0sers/srikenth.cltha/Deskoop/Liberobroject/Verilog/PCIE Demo/simulation/testbench presynth simulaticn.log'

Log | Cores

Figure 27 * Log Window

Configuring and Generating Firmware
1. Click Configure Firmware Cores under Handoff Design for Firmware Development in Design
Flow and clear all drivers except CMSIS as shown in Figure 28.

Reports 5 % | EPcte Demotop 5 % | statpage 5 % SERDESIF_1 userbfin,_ @ x| KB oEstG FRMUARE® & X

g T

Core Type Version Compatble Hardware Instance

Generate: | Instance Name
2.2,101 4 |PCle_Demo_MSS

SmartFusion2_CMSIS

1 [?4 % SmartFusion2_CMSIS_0

0_Driver_0
!3' SmartFusion2_MSS_HPDWA Driver_0 SmartFusion2_MSS_HPDMA Driver 2.0.101  |PCle_Demo_MSS

W Spaithusan? s NVAGERD SmartFusion2_MSS_NVM_Driver 2.2.100 + [PCIe_Demo Mss

(i 57 TS 0255 _System_SCNEESiRGver D SmartFusion2_MSS_System_Services_Driver 2.3.100 ., |PCle_Demo_M3S

2.0.101 [FCle Demo_MSS

SmartFusion2_MSS_Timer_Driver

Ooo|aolo

B SmartFuson2_MSS Tiger Driver 0

Figure 28 ¢ Configuring Firmware
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Click Export Firmware. The Export Firmware dialog box is displayed as shown in Figure 29.

e D ===

Location: itha'\DesktopLiberoProject\Verilog\P CIE_Demo|

reate project| |SoftConsole3.4 -

Figure 29 * Export Firmware

Browse the Location to export the firmware project.

Select the Create Project check box.

Select SoftConsole3.4 from the drop down list.

Click OK. The successful firmware generation window is displayed.

oo hA DN

Click OK. The log window is displayed as shown in Figure 30.

Log

€ Erors i, Warnings i Info

0Inf£:: The file \Users\srikanth.aitha\Desktop\LibercProject\Verilog\PCIE !

Deaigr ins t
Open Firmware Wiew
L LR 2 TR S LN TS Y weceaainlly eyparted to Lo\ Hsers\srikanth. aitha\Deskeop\LiberoProjeet\VerilaghPCIE_Demo\firmware'.
I"Infl:: Softfonsole workspace was successfully generated.

Info: Read more on how Libero Sof integrates with your software development ERWVironment.

Figure 30 * Log Window
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Step 2: Creating an eNVM Client

The HDL and logical design portion of the demo is now complete. The following sections describe the
creation of the Cortex-M3 firmware used to initialize the MSS and SERDESIF.

The eNVM client has to be uploaded with the firmware application to initialize the SERDESIF through
CoreConfigP. The Cortex-M3 processor executes the code in the eNVM after the SmartFusion2 device
has been reset. In this design the eNVM client is created with the firmware application code to initialize
the SERDESIF.

1. To build the firmware eNVM client, invoke the standalone SoftConsole IDE. The SoftConsolelDE
Project Workspace window is displayed as shown in Figure 31.

S€ C/C++ - Microsemi SoftConsole IDE v3.4 - - — Bt - o= e
File Edit Source Refactor Mavigate Search Project Run Windew Help
(=] = 7 -6 B i H-0-Q 7 B T o [Edes)
[ Project Explorer &2 =0 = QE= outi 2 ©'Mek |~ O
Bl G An butline is nof available.
[El Problems 52 ™. ¥ Tasks| & Console| & Prupertie;_ S|

Oitems )
Description Resource Path Location  Type

Figure 31 « SoftConsole IDE Project Workspace
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2. Import the existing project into workspace as shown in Figure 32.

S€ C/Cs - — - - C L et —— o )
File Edt Source Refactor Navigate Search Project Run Window Help
- 9 P S T I G e - ®([@eeT)
(7 Project xporer &3 =0 = 0)(E owi 2\ @wmak| = O
o An outine s not avalable
= 5¢ Impore (=] i
Select N
Create new projects from an archive file or directory. E =’
R e . =
Select an import source:
1 [T import: |
O Bport type filter text Import Projects —
&) Refresh 5 4 (= General Select a directory to search for existing Eclipse projects. A
e File -
2 Existing Projects into Workspace|

T File System ® Select root directory:  C:\My_Practice\PCIE_Demo\SoftConsole\PCle I

] Preferences

> = CfCes ) Select archive file: Browse...
> @ CVS Projects:

> [ Run/Debug

> @ Team 3 (91 PCle_Demo_MSS CM3_app (CAMy_Practice\PCIE Demaol\SoftCon| [ Select Al

PCle_Demo_MS5_CM3_hw_platform (C:\My_Practice\PCIE_Demo

Deselect All

Cl) F—— "

[¥|opy projects into workspace 4

@ < Back Next > Frish | [[f|  Working sets
(] Add project to working sets

- Select...

[2 Problems 2 ] Tasks| Bl Console| = Properties| e

5
@ Cade e (e ) [ o

Figure 32 « Import the Existing Project into Workspace
a. Right-click Project Explorer tab on the left pane and select Import.... The Import dialog box is
displayed.

b. Select Existing Project into Workspace under General folder and click Next. The Import
Projects dialog box is displayed.

c. Click Browse to navigate to the SoftConsole project folder.

d. Select PCle_Demo_MSS_CM3. app and PCle_Demo_MSS_CM3_hw_platform check boxes
under Projects.

e. Select Copy projects into workspace check box.
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e. Click Finish. The SoftConsole Workspace window is displayed as shown in Figure 33.

-
SC C/C++ - Welcome to Microsemi SoftCenscle IDE v3.4 - Microsemi SoftConsole IDE v3.4

File Edit Source Refactor Mavigate Search Project Run  Window Help

s-Eel 8 9 s G Er @ RD B O A D = Eaes)
o« 5] %5 & - -
f[\jplojcdl{lplmelm = BB welcome = B[ 8% outli 2 Mak}mﬁ

= % || Microsemi SoftConsole |DE v3.4

An outline is not available.

I =% PCle Demo_MSS_CM3_app
| (2 PCle_Demo_MS5_CM3_hw_platform SoftConsole is a free software development environment

- -7 -7 enabling the rapid preduction of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SeftConscle

lets you write software that is immediately compiled into a usable binary.

(=+ Start a Project
To begin your work, click File > New > C Project
Give your preject a name, and select a toclchain if you are going to

Then click Finish.
Add an initial source file with File > New > Source File

Add code to it, and click the Build All icon.

(=) Existing Code
You can also import an existing source tree using
File > Import...
and click
‘General > File System

be compiling for a target other than the default choice of the Microsemi Cortex-M3.

m

BA Problems &2 Z. Tasks} =] Con;o\e] =] Propemeq

= =8
0 items
Description = Resource Path Location Type

) 0 iterns selected

Figure 33 * SoftConsole Workspace

3. Select the projects PCle.Demo MSS_CM3_app and PCle_Demo_MSS_CM3_hw_platform in

the Project Explorer by pressing down the CTRL key.
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4. Right-click and select Build Configurations > Set Active > Release as shown in Figure 34.

SC C/C++ - Welcome ta Microsemi SoftCansole IDE v3.4 - Microsemi SoftConsole IDE v3.4 i AN il = | B jwweS
File Edit Source Refactor Mavigate Search Project Run  Window Help
n-Bel s 9L H- -G RS B0 QU ISP w [T
F] v s v % - -
[ Project Explorer &2 =g Welcome &2 = 0O|[ 8z outli &2 Makw =t
= § Y| Microsemi SoftConsole IDE v3 4 PO =
=3 PCle_Dermno_MS5_CM3_app gL
s [=5 PCle_Demo_MSS CM3 hw olatform SoftConsole is a free suftwa.m development environment =
N , petion of Cand C++ executables for processors
i semi devices, Creating a project inside SoftConsole
Go Into hat is immediately compiled into a usable binary,
i2| Copy Ctrl+C
Paste Ctrl+V ‘
Delete Delete click File = New = C Projgt )
ame, and select a teelchain if you are going to
Move... arget other than the default choice of the Microsemi Cortex-M3. <
Rename... F2 -i
i1y Import... file with File = New = Source File
ed Export.. lick the Build All icon.
Build Project I
Clean Project
&' Refresh F5 an existing source tree using
Close Project ]
Close Unrelated Projects tem
Exclude from build...
Build Configurations 3 Set Active (IR V1 Debug
Make Targets 3 Build 2 | 2 Release
= =
Index 3 Delete resqfifge cfgs...
ST T Maggll .. 3 Path Location Type
Run As » w o
Debug As 3
Profile As 3
Team 3
Compare With 3
e £ o
o = 2items Restore from Local History...

Figure 34 * Release Mode Option
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5. Select PCle_Demo_MSS_CM3_app. Right-click and select Properties as shown in Figure 35.

5C C/C++ - Welcome to Microsemi SoftConsele IDE v3.4 - Microsemi SoftConsole IDE v3.4
File Edit Source Refactor Mavigate Search Project Run Window Help
|.=il>v ﬁﬁ' :"§ éj’ @vﬁ‘ﬁvgv@v &v@v %vc
[ Project Explorer &7 5%& > =0 Welcome &3
< B .
» i PCle Demo M0 , |osemi SoftConsole IDE v3.4
=% PCle_Demo_k ——
Go Into ftConsole is a free software development er
) ) abling the rapid production of C and C++ ¢
Open in New Window ailable for use in Microsemi devices: Creatir
rs you write software that is immgdiately cor
E Copy Ctrl+C
Paste Ctrl+V
#  Delete Delete | Starta Project
Move To begin your work, click File = New > C
e Give your project a name, and select a too
Rename... F2 be cempiling for a target other than the d
Then click Finish,
\HH Impﬂrt”l . e . -
ey Export.. Add an initial source file with File > New
Build Project Add code to it, and click the Build All icon
Clean Project
-;?“L. Refresh Fa By EKiStil'lg Code
Close Project You can also import an existing source tre
File > I rt..
Close Unrelated Projects anlu:lecliclslz-npo
.
Exclude fromiigiid... General » File System
Build Configurations L
Make Targets * | Additional Information
nd » * Release Motes
http:/fwww.actel.com/download/soft
Nhwer * Online documentation
T
Run As r
Debug As p pblems 23 ] Tasks| & Console| 1
Profile As L -
Team y [Phion
Cormpare With J
Restore from Local History...
Properties Alt+Enter

== PCle_Demo_MS5_C M3_app

W

Figure 35 * Properties Option
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6. The Properties for PCle_Demo_MSS_CM3_app window is displayed as shown in Figure 36.

SC Properties for PCle_Demo_MSS_CM3 app ' » o - - I : 5] | S|

[type filter text Resource = v =
Resource Path:  /PCle_Derno_MSS_CM3_app
Builders T e
C/C++ Build ~¥p& roje

Location: D\Microsemi_pr\PCIE_Demo\SoftConsole

C/C++ General
for aEnEn \PCle_Demo_M55_CM3\PCle_Demo_MSS_CM3_app

Project References
Refactoring History Last modified: Junel7, 2013 2:25:26 AM
Run/Debug Settings

Text file encoding

@ Inherited from container (Cpl252)

() Other: | Cpl252

Mew text file line delimiter

@ Inherited from container

() Other:

l Restore Qefaults-] l Apply ]

@) [ ok |[ cance |

Figure 36 * Properties Window

7. In the Properties for PCle.Demo_MSS_CM3_app window, expand the C/C++ Build option and
select Settings.
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8. Select Miscellaneous and provide the release mode linker script file to the linker by changing the
‘Linker flags’ field to “-T../../PCle_Demo_MSS_CM3_hw_platform/CMSIS/startup_gcc/production-
smartfusion2-execute-in-place.ld” as shown in Figure 37.

, = o
SC Properties for PCle_Dema_MSS_CM3 [ o 0 e ]

type filter text Settings - > w
Resource
Builders
C/C++ Build Configuration: [Release [ Active ] vl [Manage Configurations...
Build Variables
Discovery Options
Environment B Tool Settings ‘ # Build Stepsl Build Artifactl Binary Parsers | & Error Parsers
Settings
Tool Chain Editor 4 B3 GNU C Compiler Linker flags  -T.././PCle_Demo_MS5_CM3_hw_platform/CMSIS/startup_gce/preduction-smartfusion2-execute-in-placeld |
C/C++ General (2 Preprocessor Generate linker memory map
Project References [ Symbols y .
Run/Debug Settings @ Directories Other options (-Klinker [option]) @ ID % %}‘ ,@\
& Optimization

(2 Debugging
(2 Warnings
@ Miscellaneous
53 GNU C Linker
@ General
(2 Libraries
|£“‘-2'-5 Miscellaneous |
3 GNU Assembler
@ General
55 Memory map generator Other ohjects 2885y
&3 GNU Intel Hex File Generator
(2 General
B3 GNU S-Record Generatar
(2 General
&3 GNU Listing Generatar
(2 General

S

S

S

"${workspace loc/PCle Demo MSS CM3_hw platform/Release/ CMSIS/startup_gec/startup_m2socco}”
"${workspace_loc:/PCle_Demo_MS5_CM3 hw_platfarm/Release/CMSIS/startup_gcc/newlib_stubs.o}"

S

S

[Rastore Qe«‘aulfs] [ Apply ]

@ [ ok J[ cancel |

Figure 37 + LD File Option

9. Click OK to close the Properties for PCle_Demo_MSS_CM3_app window.
10. To clean and build the project, select Project > Clean as shown in Figure 38.

. A
S5C C/C++ - Microzsemi SoftConsole IDE \r3.4‘

File "Edit Source Refactor Mavigate Search [ Project | Run  Window Help

r<_’|>v|.g|"*||ﬂ—1IJ = BN N Rl Open Project R

- - Close Project

[ Pro I o3 =
b 28 PCle_Demo_MSS_CM3_app g Build All Ctri+B
[ = PCle_Demao_MS5_CM3_hw_platform Build Configurations 3

Build Project
Build Wearking Set »

Clean...

Build Automatically

Figure 38 ¢ Building the SoftConsole Project
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11. The Clean window is displayed. Click OK to build the SoftConsole projects as shown in
Figure 39.

SC Clean . B W L@ﬂ

Clean will discard all build problemns and built states. The next time a build occurs
the projects will be rebuilt from scratch.

@ Clean all projects () Clean projects selected below

=5 PCle_Demo_MSS_CM3_app
] =p Cle_Demo_MS55_ CM3_hw_platform

Start a build immediately

(@ Build the entire workspace

() Build only the selected projects

| ok || cancel

P N F &

Figure 39 * Clean and Build SoftConsole Projects
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12. The SoftConsole creates a hex file in the Release folder under the PCle_Demo_MSS_CM3_app
project as shown in Figure 40.

5C C/C++ - Microsemi SoftConsole IDE v3.4

File Edit Source Refactor Mavigate Search Project Run
L="'j'v &) § Iy @vﬁﬁvi}'v@}v
\[ Project Explorer &7 ===
B PCle_Demo_MS5_CM3_app
g:;? Binaries
[l Includes
= Release
main.o - [arm/eg] !
ﬁ PCle_Dermno_MS5 CM3_app - [arm/1e] l
/= main.d
| & makefile |

mermory-map.xml

lerto mk
| = PCIe_Dema_Mss_cma_apEE'l

=[ PCIE_Demo_Was_Us_app.s

=] PCle_Demo_MS5_CM3.app.map
|| PCle_Dermo_MSS_CM3_app.srec
[ & sources.mk

[ @ subdir.mk

[£] main.c

== PCle_Demo M S5 CEM3_hw_platform

Figure 40 » Generated Hex File

13. Close the SoftConsole project window.

14. Open<the Libero project and PCle_Demo_top tab. Double-click PCle_Demo_0 and go to
System Builder - Memories tab to add the eNVM data storage client.
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15. The eNVM configurator window is displayed as shown in Figure 41.

(® System Builder - Memories

> Device Features > Memories

Configure your external and embedded memories

) Peripherals » » Clocks Microcontroller SECDED ) Security 2 ) Interrupts » ) Memory Map

AN

Avallable Client types

Data Storage
Serialization

Add to System...

Usage Statistics
Availzble Pages: 2032
UsedPages: 0

FreePages: 2032

User Clients in eNVM

Client Type

Client Name DepthxWidth Start Adcress{Hex) Pagesat | Pageend |

Initialization Order

Lock Start £

0

<

Edit

v

Delete

Back

Figure 41 » System Builder - Memory eNVM
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16. Select Data Storage under the Available client types tab and click Add to System. The Add
Data Storage Client window is displayed as shown in Figure 42.

G\ Add Data Storage Client

T TS W S

2 [l |

Client name: |
eNVM
Content:

@ Memory file:
Format:
[7] Use absslute addressing e
() Content filled with 0s
(7)) No Content (Client is a placeholder)
Start address: 0x 0 =
bits
Mumber of Words: 1

[Juseasrom D

Size of word:

[ use Content for Simulation

Help

(decimal)

Ok

] [ Cancel

J

%

Figure 42 » Add Data Storage Client

17. Enter a data storage Client Name as eNVM in the Add Data Storage Client window.
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18. Browse for the.hex file generated (as shown in Figure 40 on page 39). The generated executable
image can be found in the Release folder under the SoftConsole project workspace as shown in
Figure 43.

Choose Memory Content File

@uv| . <« PCIE Demo » SoftConsole » PCle Demo_MSS_CM3 » PCle_Demo_MS5 CM3_app » Release

Organize « MNew folder

MName Date modified Type

[ Favorites
Bl Desktop || PCle_Demo_MS5_CM3_app.hex 6/17/2013 7:55PM  HEXFile 4 KB
4. Downloads

m

= Recent Places

|| .l Libraries
3 Documents | 4

J‘. Music
= Pictures
EE videos
I "M Comnuter S
File name: v [intel-HexFiles (hegting v
H
[ Open l ’ Cancel ]

Figure 43 *» Browsing for .hex File

19. Click OK in the Add Data Storage Client window as shown in Figure 44.

f§ . T N — 7
(*) Add Data Storage Client — l B

Client name:  eNyM
eNVM
Content:

@ Memory file: :ﬁS_aEReIeaseEZ_MSS_IGL2_MSS_CM3_app.hex :]
Format:
[ Use absslute addressing (3]

(™) Content filed with 0s

(). Mo Content{Client is a placehalder)

Start address: 0x 0 =
Size of word: bits
Mumber of Words: 3120 (decimal)

D Use as ROM e

[ use Content for Simulation

Help Ok ] [ Cancel

Figure 44 + Add Data Storage Client
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( System Builder - Memories B |G
Device Features Memories » » Peripherals » } Clocks Microcontroller SECDED Security »_Interrupts » > Memory Map »
Configure your external and embedded memories
{ ENVM
Available Client types User Clients in eNVM
Data Storage
Serialization | Client Type Client Name Depthxwidth Start Address{Hex) Page Start Page End Initialization Order Lock Start #
|o Data Storage eNvM 1368x 8 ] ] 10 NfA =]
Add to System...
Usage Statistics
Available Pages: 2032
Used Pages: 11
Free Pages: 2021
< T b
=

Figure 45 * Modify Core - ENVM

21. Save PCle_Demo_top and regenerate the PCle_Demo_top component by clicking Generate
Component in SmartDesign.

Step 3: Developing theSimulation Stimulus

During the design process, SERDESIF was configured for the BFM simulation model. The BFM
simulation model replaces.the entire PCle interface with a simple BFM that can send write transactions
and read transactions over the AHB-Lite interface. These transactions are driven by a file and allow easy
simulation of the’FPGA design connected to a PCle interface. This simulation methodology has the
benefit of focusing on the FPGA design since the SmartFusion2 PCle interface is a fully hardened and
verified interface.

This section describes how to modify the BFM script (user.bfm) file that was generated by SmartDesign.
The BFM script file simulates PCle writing/reading to/from the MSS through the FIC_O0.
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1. Open the SERDESIF_1_user.bfm file. To open the SERDESIF_1_user.bfm, go to the Files tab >
Simulation folder, and double-click the SERDESIF 1 user.bfm. The SERDESIF 1 user.bfm file is
displayed, as shown in Figure 46.

(2 Libero - DAMicrosemi_pri\PCIE_Demo\PCIE Demopri RN ey

Project File Edit View Design Tools Help

NS H2N9 0

Files g X

| E3 pcie_pemo_top [] | EZPcie_Demo [ | &2 Peie_Demo_vss SERDESIF_1_userbfmn  [J |
[ phy_synthesis - 13
4 [ simulation 2 ¢ Enter your BFM commands in this file.
bfmtovec.exe 33
B bfmtovec.lin 4 # Syntax:
bfmtovectd.exe g : _______
I% bfmtovec_compiletcl T 7 # memmap regource name base address;
B CompileDssBfm.tel 82 - -
% coreahblite_usertb_ahb_master.bfm 9% write width resource_name byte_offaet datar
% coreahblite_userth_ahb_masterQ.vec 10 # read width resocurce name byte offset;
I% coreahblite_userth_ahb_masterl.bfm E # readcheck width rescurce_name byte offset data:
% coreahblite_usertb_shb_masterl vec 13?
% coreahblite_usertb_include.bfm 14 ’
% medelsim.ini 15 procedure main;
% modelsim.ini.sav &
% peripheral_init.bfm | ]1; # add your BFM commands below:
(1 SERDESIF_1_compile_bfm.tcl r 19 return
By SERDESIF_1_init.bfm
[ SERDESIF_1_user.bfm
B subsystem.bfm
% test.bfm
% user.bfm
[ smartgen
> [ SoftConsole
[ stimulus
> [ synthesis | 4
> [ tooldata i
=S
|Design Hierarchy | Stimulus Hierarchy | Files |

Figure 46 » SmartDesign Generated SERDESIF_1_user.bfm File

2. Modify the SERDESIF 1 _user.bfm to add the following bfm commands of writing and reading:
memmap GPIO 0x40013000;
memmap eSRAM 0x20000000;

procedure main;

# add your BEM commands below:
walt 500us;

wait 500us;

write w GPIO 0x00 0x5;

GPIO 0x04 0x5;

GPIO 0x08 0x5;

write GPIO 0x0C 0x5;

write w
w
w

write w GPIO 0x10 O0x5;
w
w
w

write

GPIO 0x14 0x5;
GPIO 0x18 0x5;
GPIO 0x1C 0x5;

write
write

write

write w GPIO 0x88 0x00;
write w GPIO 0x88 0x01;
write w GPIO 0x88 0x02;
write w GPIO 0x88 0x04;
write w GPIO 0x88 0x08;
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write w GPIO 0x88 0x10;

write w GPIO 0x88 0x20;

write w GPIO 0x88 0x40;

write w GPIO 0x88 0x80;

write w eSRAM 0x00 0x12345678;
write w eSRAM 0x04 0x87654321;
write w eSRAM 0x08 0x9ABCDEFO;
write w eSRAM 0x0C OxOFEDCBA9;
readcheck w eSRAM 0x00 0x12345678;
readcheck w eSRAM 0x04 0x87654321;
readcheck w eSRAM 0x08 O0x9ABCDEFO;
readcheck w eSRAM 0x0C O0xOFEDCBAY9;
return

3. The modified BFM file appears similar to the file shown in Figure 47.
BFM commands added in the SERDESIF 1 user.bfm do the following:

— Perform write to MSS GPIO
— Perform write to eSRAM
— Perform read-check from eSRAM

=Y Libero - C:\Users\srika

Project  File Edit

W= WA >)

Files

View Design Tools Help

> [ designer -
b [ firmware
> [ hdl i
4 [ simulation
bfmtovec.exe
B bfmtoveclin
bfmtovectd.exe
B bfmtavec_compilelog
B bfmtovec_compiletel
B cM3_compile_bfm.tel
B CompileDssBfm.tcl
B coreahblite_usertb_ahb_masterd.bfm
B coreahblite_userth_shb_master).vec
B coreahblite_userth_shb_masterl bfm
B coreahblite_usertb_ahb_masterl.vec
B coreahblite_usertb_ahb_master2.bfm
B coreahblite_userth_shb_master2.vec
B coreahblite_userth_shb_master3.bfm
B coreahblite_usertb_ahb_master3.vec
B coreahblite_usertb_includedbfm
B ENVM_init.mem
B modélsim.ini
B modelsim.ini.sav
B peripheral_init.bfm
(L presynth
B mnde
B SERDESIF 1.vec
B SERDESIF_1_compile_bfm.tcl
B SERDESIF_1_init.bfm
B SERDESIF_1_userbfm
B subsystemdbfri
B test.bfm
B testvec
B userbfm
B wavede
[ smartgen
> [ SoftConsole
> [ stimulus
> [J synthesis
b [ tooldata -

i

Reports @ % | Epcle Demotop & X | startPage & % SERDESIF_1_userbfin & X
¢ = Sy

B 1

2 # Enter yous BFM commands in this file.

%

4 # Syntax

S F -

6 %

7 & memmap| resource name base address;

3 #

8 % write width resource_name byte_offset data;
@6 # read width resource name byte offset;
11 # Zeadcheck width resource_name byte_offset data;
12 ¥
i3 #

14 memmap GPIC 0x40013000;
15 memmap eSRAM 0x20000000;
16 procedure main;

17

& # add your BFM commands below:

19 wait 500us;
20 wait 500us;
21

22 write w GPIO
23 write w GPIO
24 write w GPIO
25 write w GPIO
26 write w GPIO
27 write w GPIO
28 write w GPIO
29 write w GPIO
30

31 write w GPIO
32 write w GPIO
33 write w GPIO
34 write w GPIO
35 write w GPIO
36 write w GPIO
37 write w GPIO

& write w GPIO
3% write w GPIO
a0
41 write w eSRAM 0x00 0x12345678;

42 write w eSREM 0x04 0x87654321;
43 write w eSRAM Ox08 OxSABCDEFO;
44 wwire w aSDAM AwAR AuATERARNG-

Figure 47 » Modified SERDES User BFM
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Step 4: Simulating the Design

The design supports the BFM_PCle simulation level to communicate with the High Speed Serial

Interface block through the master AXI bus interface. Although no serial communication actually goes

through the High Speed Serial Interface block, this scenario allows validating the fabric interface

connections. The SERDESIF_1_user.bfm file under the <Libero project>/simulation folder contains the

BFM commands to verify the read/write access to MSS GPIOs and eSRAM.

This section describes how to use the SmartDesign testbench and BFM script file to simulate the design.
1. To generate the HDL testbench file follow the below instructions,

a. From the File menu, choose New > HDL Testbench as shown in Figure 48.

Project Edit View Design Tools SmartDesign Help

Iiw [ Mew ¥ |E] SmartDesign
; Open... =
Design Floy F_0_userbfm & X | Reports & X
Close PCle_Demo_top ]  SmartDesign Testbench =
PCle_Def M  Save Ctrl+§ HDL Testbench ) [ |ﬂ AP0, U A
[, SavePCle Demo_top As... SDC (sdc)
To
P Import N 1/0 Constraint (PDC) File
F e s N Floorplan Constraint (PDC) File
Simulation Script (do)
Export 3 =
VHDL Library 3
=l Print PCle_Demo_top Ctrl+P
-

4 b Create Constraints
4 "= /0 Constraints

Figure 48 « HDL Testbench

The Create New HDL Testbench File dialog box is displayed as shown in Figure 49.

- —
7] Create New HDL Testbench File (o ]

HOL Type

@ Verilog ) vHDL

MName:

testhench|

Initialize file with standard template
Instantiate Root Design
Set as Active Stimulus

[ Help ] [ QK ] [ Cancel

Figure 49 * Create New HDL Testbench File

b. Select Verilog or VHDL under HDL Type.
c. Enter testbench as a name of the new hdl testbench file and click OK.

2. Add the wave.do file to the PCle demo design simulation folder by clicking File > Import >
Others.
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3. Browse to the wave.do file location in the design files folder:
M2S_PCIE_Control_Demo_DF/Source Files. Figure 50 shows the wave.do file under simulation
folder in the Files window.

4 [ simulation -
bfmtovec.exe
% bfmtovec.lin
bfmtovectd.exe

B bfmtovec_compilelog B
% bfmtovec_compile.tcl

B CompileDssBfm.tcl

% coreahblite_usertb_ahb_masterl.bfm
% coreahblite_usertb_ahb_master(.vec
% coreahblite_usertb_ahb_masterl .bfm
% coreahblite_usertb_ahb_masterl .vec
% coreahblite_usertb_include.bfm

% modelsim.ini

B peripheral_init.bfm

[ presynth

% run.do

By SERDESIF_1.vec

% SERDESIF_1_compile_bfm.tcl

By SERDESIF_1_init.bfm

B SERDESIF_1_userbfm

B subsystem.bfm

% test.bfm

% test.vec

B testbench_presynth_simulation.log

% user.bfm

% weirm.wif

% wave.do -

| Design Hierarchy | Files | SﬁmulusErard’wr N

m

Figure 50 » Wave.do File under Simulation Folder

4. Open the Libero SoC project settings (Project > Project Settings).

5. Select Do File under Simulation Options in the Project Settings window. Change the
Simulation runtime to 250us, as shown in Figure 51 on page 48.
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6. Click Save.

#1 Project Eli

Device .
Device I/0 Settings Use automatic DO file T
Preferred HOL Type Simulation runtime: 250us Restore Defaults
|| 4 Design Flow Testbench module name:  testhench
Simulation Options
|DO File Top level instance name:  <top>_0
Waveforms

R || Generate vCD file
Vsim commands

4 Simulation Libraries VCD file name: power.ved

A
SmartFusion2 lect Verilog Language Syntax
COREAHBLITE_LIB

[ verilog 2001

[ system verilag

Select VHDL Language Syntax
[T vHDL 2008
User defined DO file: E]

DO command parameters:

Figure 51 * Project Setting — Do File Simulation Runtime Setting

7. Select Waveforms under Simulation Options as shown in Figure 52:
— Select Include Do file.
— Select Log all signals in the design.
— Click Close to close the Project settings dialog box.
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— Select Save when prompted to save the changes.

-

G\ Project Settings P S
Device
Indude DO file
Device [/O Settings @ Save
Preferred HDL Type wave.do E]
Design Flow
4 Simulation Options Display waveforms for |top_level testbench -d ]
DO File
7 } ; }
Waveforme Log all signals in the design

Vsim commands
4 Simulation Libraries

SmartFusion2

COREAHBLITE_...

Figure 52 * Project Setting — Waveform

To run the simulation, double-click Simulate under Verify Pre=Synthesized Design in the Design Flow
window.
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ModelSim runs the design for about 450us. The ModelSim transcript window displays the BFM
commands and the BFM simulation completed with no errors, as shown in Figure 53.

Edit View Bookmarks

Window Help

ic

BFM: Data Write 40013083 00000020
BFM:4l:write w 20000000 123435673 at 233250 ns

BFM: Data Write 40013082 00000040

BFM:42:write w 20000004 87654321 at 233550 ns

BFM: Data Write 40013082 00000020

BFM:43:write w 20000008 9abedef( at 233850 ns

ESRAMO: Word Write 00000000=12345678 at 233950 ns

BFM: Data Write 20000000 12345678

BFM:44:write w 2000000c Ofedcba® at 234050 ns

ESRAMO: Word Write 00000004=87654321 at 234150 ns

BFM: Data Write 20000004 87654321

BFM:46:readcheck w 20000000 12345678 at 234250 ns

ESRAMO: Werd Write 0000000&8=8zbcdefl at 234350 ns

BFM: Data Write 20000008 9abcdefd

ESRAMO: Word Write 0000000c=0fedcbad at 234550 n3

BFM: Data Write 2000000c Ofedcbad

BFM:47:readcheck w 20000004 87654321 at 2346350 na

ESRAMO: Word Read 00000000=12345678 at 234700 ns

BFM: Data Read 20000000 123456723 MASK £ at 234800.020000ns
ESRAMO: Werd Read 00000004=27654321 at 2349300 ns3

SFM: Data Read 20000004 87654321 at 235000.020000ns3
BFM:48:readcheck w 20000008 3abcdefl at 235030 n3

ESRAMO: Word Read 00000004=37654321 at 235100 n3

BFM: Data Read 20000004 87654321 MASK L at 235200.020000ns
ESEAMO: Word Read 00000008=%abcdefl at 235300 ns

SFM: Data Read 20000008 %abcdefl at 235400.020000na3
BFM:49:readcheck w 2000000c Ofedcba® at 235450 ns

ESEAMO: Werd Read 00000008=%zbcdefl at 235500 ns

BFM: Data Read 20000008 9abedefl MASK: £ at 235600.020000ns3
ESRAMO: Word Read 0000000c=0fedcba’d at 235700 n3

5FM: Data Read 2000000c Ofedcba’d at 2353800.020000ns3

BFM:5l:return

ESRAMO: Word Read 0000000c=0fedcba% at 235900 nd

BFM: Data Read 2000000c Ofedchbal MASK £ at 236000.020000n3
ESEAMO: Word FRead 00000010=xxxxxxxx at 236100 ns

SFM: Data Read 20000010 Oxxxxxxxx at 236200.020000ns

R AR AR Ak O 9k 9 B 9k 9k 9k Ok ok ok ok 9k Ak ok ok R ok ok dh e B 9k 9k 9k 9k 9F 9F 9k 9k ok ok ok o

#
# SERDESIF_1 BFM Simulation Complete - 28 Inatructignagsplic ERRORS

#
FEFH R R R R R R AR A A R R A A

Figure 53 « SERDES BFM Simulation

8. Figure 54 shows the waveform window with MSS GPIO output signals.

thench/PCIe_Demo_top_0/PCle_Demo_0/GPIO_2_M2F

4., ftestbench/PCle_Demo_top_0/PCle_Demo_0/GPIO_3_M2F
4., ftestbench/PCle_Dem p_0/PCle_Demo_0/GPIO_4_M2F
4. ftestbench) mo_top_0/PCle_Demo_0/GPIO_5_M2F
4., ftestbench/PCle_Demo_top_0/PCle_Demo_0/GPIO_&_M2F

ftestbench/PCIe_Demo_top_0/PCle_Demo_0/GPIO_7_M2F

“‘\ =l oo oo oo o

Figure 54 + Simulation Result with MSS GPIO Signals
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Step 5: Generating the Program File

1. Double-click I/O Constraints in the Design Flow window as shown in Figure 55. The 1/O Editor
window is displayed after completing Synthesize and Compile.

_
=,

PCIe_Demo_top

Tool

v 4 F Create Design jl
&5 System Builder

7y L5 Configure MSS

B3 Create SmartDesign l
Create HDL

E Create SrmartDesign Testbench
Create HDL TestBench

i View/Configure Firmware Cores
¥ Verify Pre-Synthesized Design

. Simulate

Create Constraints

19

k A
- v

Implement Design
*S Synthesize
[ » Verify Post-Synthesis Tmplementation
S5 Compile
«[| Configure Flash*Freeze
915 Place and Route
b Edit Cabpstraints
I "E o Com:traintsl
Tirning Constraints il
i . .

[

Design Flow Catalog

Figure 55 ¢ 1/0 Constraints

2. The I/O Editor is displayed. Make the pin assignments shown in Table 5. After the pins have been
assigned, the 1/0 Editor is displayed as shown in Figure 56 on page 53.

Table 5 « Port to Pin Mapping

Port Name Pin Number
CLKO_PAD u7
GPIO_0_M2F A18
GPIO_1_M2F B18
GPIO_2_M2F D18
GPIO_3_M2F E18
GPIO_4_M2F A20
GPIO_5_M2F D20
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Table 5 « Port to Pin Mapping (continued)

Port Name Pin Number
GPIO_6_M2F E20
GPIO_7_M2F B20
GPIO_8 M2F R3
GPIO_9_M2F R4
GPIO_10_M2F AE2
GPIO_11_M2F AD1
SWITCH AA2
SDIF1_PERST_N R30

These pin assignments are for connecting below on the SmartFusion2 Development Kit.

CLKO_PAD to 50 MHz Clock Oscillator

GPIO_0 to GPIO_8 for LEDs

GPIO_8 to GPIO_11 for DIP switches

SWITCH for SW3

SDIF1_PERST_N to PERST of PCle Edge connector

52

Revision 3




& Microsemi

SmartFusion2 SoC FPGA PCle Control Plane Demo - Libero SoC v11.4 User Guide

File Edit View Tools Help

Welox &% 5

Ports | Package Fins | Package Viewer |

Port Mame | T Direction |+ I/0 Standard | = Pin Mumber |+ Locked | = Macro Cell | =
1 CLEO_PAD Input LVEMOS25 u7 ADLIB:INBUF
P oERSTN | mpa | - | A | ADLIB:SYSRESET
3 GPIO_0_M2F Output LViCMOS25 AlB ADLIB:OUTBUF
4 GPIO_1_M2F Output LVCMOS25 B8 ADLIB:OUTBUF
5 GPIO_2_M2F Output LVCMOS25 D18 ADLIB:OUTBUF
6 GPIO_3_M2F Output LViCMOS25 E18 ADLIB:OUTBUE
7 GPIO_4_M2F Output LVCMOS25 AZ0 ADLIB:OUTBUF
8 GPIO_5_M2F Output LVEMOS25 D20 ADLIE: QUTBUF
9 GPIO_6_M2F Output LVCMOS25 E20 ADLIB:OUTBUF
10 GPIO_7_M2F Output LViCMOS25 B20 ADLIB:OUTBUF
11 GPIO_8_F2M Input LVEMOS25 R3 ADLIB:INBUF
12 GPIO_9_F2M Input LVCMOS25 R4 ADLIB:INBUF
13 GPIO_10_F2M Input LViCMOS25 AE2 ADLIB:INBUF
14 GPIO_11_F2M Input LVCMOS25 ADL ADLIB:INBUF
15 (P) REFCLKO_P Input VDS F1 ADLIB:INBUF_DIFF
16 (M) REFCLKO_N Input VDS El ADLIB:INBUF_DIFF
17 RXDO_N Input -- 9 ADLIB:SERDESIF 1
18 RXDO_P Input P 18 ADLIB:SERDESIF 1
19 RXD1_N Input - - H10 ADLIB:SERDESIF 1
20 RXD1_P Input -- H9 ADLIB:SERDESIF_1
21 RXD2_N Input - n ADLIB:SERDESIF 1
22 RXD2_P Input 3 1o ADLIB:SERDESIF 1
23 RXD3_N Input - G11 ADLIB:SERDESIF_1
24 RXD3_P Input - G10 ADLIB:SERDESIF 1
25 SDIF1_PERST_MN Input LVEMOS25 R30 ADLIB:INBUF
26 SWITCH Input LVCMOS25 AR ADLIB:INBUF
27 TXDO_N Output -- A2 ADLIB:SERDESIF_1
28 TADO_P Output - B2 ADLIB:SERDESIF 1
29 TXD1_N Output == Ad ADLIB:SERDESIF 1

Figure 56 « 1/0 Editor

3. After updating I/O editor, click Commit and Check.
4. Close the I/O editor.

5. Click Generate Bitstream as shown in Figure 57 to complete place and route, verify timing, and
generate the programming file.

Project File Edit View Design Tools Help
~ =

N 20

Design Flow Generate Bitstream b

Figure 57 * Generate Bitstream

Revision 3 53



& Microsemi

SmartFusion2 SoC FPGA - PCle Control Plane Demo
Running the Demo

Demo Setup

1. Connect the FlashPro4 programmer to the J59 connector of SmartFusion2 SoC FPGA

Development Kit.

2. Connect the jumpers on the SmartFusion2 Development Kit, as shown in Table 6.
Note: While making the jumper connections, the power supply switch SW7 on the board should be in OFF
position.
Table 6 « SmartFusion2 SoC FPGA Development Kit Jumper Settings
Jumper Pin (from) Pin (to) Comments
J70, J93, J94, J117, J123, J142, J157, J160, J167, 1 2 Default
J225, J226, J227
J2 1 3 Default
J23 2 3 Default

3. Connect the power supply to the J18 connector.
4. Switch the power supply switch SW7 to ON position.
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5. To program the SmarFusion2 device double-click Run PROGRAM Action in the Design Flow
window as shown in Figure 58.

Design Flow

PCle_Demo_top

Tool
4

S S

P Create Design
&4 System Builder
E& Create SmartDesign
Create HDL
] Create SmartDesign Testbench
Create HDL Testbench
4 ¢ Verify Pre-Synthesized Design
. Simulate
» Create Constraints
P Implement Design
S Synthesize
4 ¢ Verify Post-Synthesis Implementation
. Simulate
By Compile
+ Configure Flash*Freeze
{13 Place and Route
» Edit Constraints
P Verify Post Layout Implementation

Edit Design Hardware Configuration
Configure Security and Pfegrammifg@ptions

v v w T

Program Design
@‘ Configure Bitstream

¢ Generate Bitstream
: Run PROGRAM Action

F

» Debug Pesign

m

-

Design ... | Designl-Era...TSﬁnﬁusHiera... I Catalog I Files I HDL Templ... |

Figure 58 * Run PROGRAM Action

6. After Successful programming, power OFF the SmartFusion2 Development Kit and shut down the

Host PC.

This dema is designed to run in any PCle Gen 2 compliant slot. If the host PC does not support

Gen 2 compliant slot, the demo will switch to Gen 1 mode.

7. Connect the J230 — PCle Edge Card Ribbon Cable to Host PC PCle Gen 2 slot or Gen 1 slot

as applicable.
Caution: Host PC needs to be powered OFF while inserting the PCle Edge connector. If it is not, the PCle
device detection and selection of Gen1 or Gen2 mode may not occur properly. This is very
dependent on the host PC PCle configuration. It is recommended that the host PC is powered

OFF before inserting the PCle card.
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8. The board setup is shown in Figure 59.

DC Power Jack

Power ON switch

PCle Edge Connector

FlashPro Connector

LED's

Push Button SW3

DIP Switches

Figure 59 » SmartFusion2 Development Kit Setup
9. Switch the power supply switch SW7 to ON position.

Running the Demo Design

This demo can run on-both-windows.and Red Hat Linux operating system.

To run the demo on Windows operating system GUI, Jungo drivers are provided. Refer to Running the
Demo Design on Windows.

To run the demo on Linux.opérating system native Red Hat Linux drivers and command line scripts are
provided. Refer to Running the Demo Design on Linux.
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Running the Demo Design on Windows

1. Power on the Host PC and check the Host PC Device Manager for PCle Device. It will be similar

to Figure 60. If the device is not detected, power cycle the SmartFusion2 Development Kit and
click “scan for hardware changes” in Device Manager.

Eile  Action View Help

&= | T HE =

4 = wi-donthus
» - M Computer

R Dizk drives

‘B Display adapters
_ oy DVD/CD-ROM drives

&‘}". Human Interface Devices
: g IDE ATASATAPT controllers
.. Keyboards

--ﬂ Mice and other pointing devices
| Monitors
-EF Network adapters

i PCI Device
TS Ports (COM & LRT)
> 2} Processors
> -% Sound, video and game controllers
> .M Systenidevices

D

5 i Universal 5erial Bus contrallers

Figure 60 » Device Manager - PCle Device Detection

2. If the Host PC has any other installed drivers (previous versions of Jungo drivers) for the

SmartFusion2PCle device, uninstall them. To uninstall previous versions of Jungo drivers follow
steps 12.and 13.

3. To uninstall previous Jungo drivers go to device manager and right-click on DEVICE as shown in
Figure 61 on page 58 device uninstall.
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= Device Manager
File  Action View Help

A NER e T

& gy wil-techsuprt-02
18 Computer
= Disk drives
By Display adapters
> e DVD/CD-ROM drives
= IDE ATASATAPI controllers

Update Driver Software..,

» 22 Keyboar Disable

o Mice an Uriinstall

» Bl Monitor

G Neboark Scan for hardware changes
" F

> 1 Ports (C Properties

- ¥ Process

-4 Sound, video and garne controllers
» & Systern devices
> i Universal Serial Bus controllers

Uninstalls the driver for the selected dewice,

Figure 61 « Device Uninstall
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4. The DEVICE uninstall window is displayed as shown in Figure 62 Confirm Device Uninstall Select
Delete the driver software for this device. After uninstalling previous Jungo drivers, make sure
that the PCI Device is detected in the Device Manager window as shown in Figure 62 Device

manager.
Confirm Device Uninstall @
.;. DEVICE
=

Warhing: vou are about bo uninztall this device from paur system.

JiDelete the driver software for this device

(] ] | Cancel

Figure 62 « Confirm Device Uninstall

Note: If the device is still not detected, check whether or not the BIOS version in Host PC is latest, and if
PCl is enabled in the Host PC BIOS.

Drivers Installation
The PCle Demo uses a driver framewaork provided.by-dungo WinDriverPro. To install the PCle drivers on
Host PC for SmartFusion2 Development Kit, use the following steps:

1. Extract the PCle_Demo.rar to C:\ drive. The PCle_Demo.rar is located in the provided design
files:
— M2S_PCIE_Control DEMO_DF\Windows_64bit\Drivers\PCle_Demo.rar

2. Run the batchfile C:\PCle_Demo\Driverinstall\Jungo_KP_install.bat
Note:Installing these drivers require Host PC Administration rights.
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3. Click Install if the window is displayed as shown in Figure 63.

[>7] Windows Security M

Would you like to install this device software?

=~ Mame: Jungo Jungo
_&' Publisher: Jungo LTD

[T Always trust software from "Jungo LTD". Install ] | Don't Install 1

Eg' You should only install driver software from publishers you trust. How canl
decide which device software is safe to install?

Figure 63 * Jungo Driver Installation

Note: If the installation is not in progress, right-click on the command prompt and select Run as

administrator. Run the batch file C:\PCle_Demo\Driverlnstall\Jungo_KP_install.bat from
command prompt.

4. Click Install this driver software anyway if the window appears as shown in Figure 64.

P @I Windows Security . w ﬁ\

@] Windows can't verify the publisher of this driver software

2 Don'tanstall thisdriver software

You sheuld checkyour manufacturer's website for updated driver software
for your device.

= Instalbthis'driver software anyway

' Only install driver software obtained from your manufacturer's website or

disealUnsigned software from other sources may harm your computer or steal
information.

-j&j See details

[

Figure 64 « Windows Security
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PCle Demo GUI

SmartFusion2 PCle Demo GUI is a simple graphic user interface that runs on the Host PC to
communicate with the SmartFusion2 PCle EP device. The GUI provides the PCle link status, driver
information, and demo controls. The GUI invokes the PCle driver installed on the Host PC and provides

commands to the driver according to the user selection.
Use the following steps to install the GUI:

1. Extract the PCle_Demo_GUI_|Installer.rar from the provided design files:
M2S_PCIE_Control_Demo_DF\\Windows_64bit\GUI.

2. Double-click setup.exe in the provided GUI installation (PCle_Demo_GUI_lInstaller\setup.exe).
Apply default options as shown in Figure 65.

-

- e — - — ; \
L. PCle Demo =R X

Destination Directory
Select the primary inzstallation directan.

All zoftware will be installed in the following locations. To install software nto a
different locations, cick the Browse button and select another dirgston.

Directory for PCle Demo
|C:"-.F‘n:ug|am Files"PCle Demo®, | [ Browse... ]

Directory for Mational Instruments products

|C:"-.F‘n:|g|am Files National Instraments", | [ Browse...

<4 Back ][ Mt x> ] [ LCancel

Figure 65 * GUI Installation
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3. Click Next to complete the installation. After successful installation the following window is
displayed:

r'{,_sl PCle Demo El_lﬂ

| Inztallation Complete
I

The installer has finished updating your system.

. ——

Figure 66 * Successful GUI Installation

4. Restart the host PC.
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Running the Design

1. Check the Host PC Device Manager for the drivers. If the device is not detected, power cycle the
SmartFusion2 Development Kit and click “scan for hardware changes” in Device Manager. Make
sure that the board is switched on.

P =

a4 Device Manager =RNCN X

File Action View Help
&= = 0
4 ey wi-danthus

- /M Computer

"t

= Disk drives
B Dizplay adapters

oy DVD/CD-ROM drives

L5 Human Interface Devices
g IDE ATA/ATAPI controllers
FE l_f Jungo
L¥ DEVICE
. l.-"‘ WinDriver

CREORT RS

"t

"t

<ZZ Keyboards

--ﬂ Mice and other pointing devices
B Maonitors

-F Network adapters

T Ports (COM & LPT)

D Processors

-% Scund, wideo and game controllers

TR RS R R W

"R

- M Sipstern devices
- i Universal 5erial Bus controllers

b,

Figure 67 * Device Manager - PCle Device Detection

Note: If awarning.symbol is displayed on the DEVICE or WinDriver icons in the Device Manager,
uninstall them and start from step1 of "Drivers Installation" on page 59.
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2. Invoke the GUI from ALL Programs > PCleDemo > PCle Demo. The GUI is displayed as shown

in Figure 68.
[ P(‘Ie-'liemo Ver11.8 s 52
& Microsemi PCle Demo
Tue, Mar 25, 2014 1:52:17 PM LinkWidihe el Genlb i e I-Cﬁ

L «

DMA Dperat-ir_ms

Fabric DMA

./.l -.“.

|
'\.‘_/’ . -
PCle Link ¥ em

Figure 68 » PCle Demo GUI
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3. Click the Connect button at the top-right corner of the GUI. The messages will be displayed on
the GUI as shown in Figure 69.

& BCle Demo Ver 118 (o = ]|
& Microsemi PCle Demo
Tue, Mar 25, 2014 1:47:08 PM Link Width: | 4x Gen 7 Rate | 53 Board | 5F2 Dev Kit lz‘ L:-Dj

.
Found 1 matching device [ Vendor ID 0x11AA, Device ID

—

1. Vendor ID: 0x11AA, Device ID: Ox11AA

Location: Bus 0x4, Slot 0x0, Function 0x0
Memory range [BAR 0]: base 0xF7C00000, size 0x100000
Memory range [BAR 1]: base 0xF7D00Q00, size (%10008

Interrupt: IRQ 9
Interrupt Options (supported interrupts):

| @ o\ SmaRTFUSION 2

PCle Link

Figure 69 * Version Information
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4. Clicking Demo Controls in the GUI displays the LEDs options and DIP switch positions as shown

in Figure 70.
"<& PCle Demo Ver 118 [E=SREE)
& Microsemi PCle Demo
Tue, Mar 25, 2014 1:48:40 PM Link Width: | 4x | Gen 2 | Rate 5G | Board|SF2DevKit [=] L‘h

PCle Link Info

Interrupt Counter® ON ON ON ON
LED1
2
LED 2 il I
Config Space LED 2 J— ] I i ]
l Enable Interrupt Session SHE i A
LED4 z Switch Modul I
e witch Module
b LED 5 ' d Clear/Disable Interrupts
LED6 [
LED T = Start LED ON/OFF Walk ]
LED & — ]

Stop LED OMN/OFF Walk

*MNOTE: PRESS APPROPRIATE PUSH BUTTGN SWITCH TO TOGGLE THE INTERRUPT COUNTER

. ry o SmaRrTFuUSIoN 2

Figure 70  Demo Controls

5. Click LEDs in GUI to ON/OFF the LEDs on SmartFusion2 Development Kit.

6. Click Start LED ON/OFF Walk to blink the LEDs on SmartFusion2 Development Kit.
7. Click Stop.ED ON/OFF Walk to stop the LEDs blinking.
8

. Change the DIP switch positions on the SmartFusion2 Development Kit (SW10) and observe the
similar position of switches in GUI SWITCH MODULE.

9. Click Enable Interrupt Session to enable the PCle interrupt.
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10. Press the push button SW3 on the SmartFusion2 Development Kit and observe the interrupt
count on the Interrupt Counter field in GUI as shown in Figure 71.

" N
< PCle Demo Ver 118 [E=REE =
. -
_ Microsemi PCle Demo
' Tue, Mar 25, 2014 1:48:56 PM Link Width; | 4x Gen| 2 Rate  5G Board | SF2 Dev Kit lz‘ I‘-ew-l
Interrupt Counter® ON  ON ON ON
LED 1 -
. 5 BN E
LED 2 — | |
LED 3 Jo— ]
Enable Interrupt Session S G ah
LED 4 J—
- Switch Madule
LED 5 | Clear/Disable Interrupts ]
LEDE
LEDT = Start LED OMN/OFF Walk
LED & —
Stop LED OM/OFF Walk
I *MNOTE: PRESS APPROPRIATE PUSH BUTTON SWITCH TO TOGGLE THE INTERRUPT COUNTER

ot o) SmartFusion2

PCle Link

Figure 71 * Interrupt Counter

11. Click Clear/Disable Interrupts to clear and disable the PCle interrupts.
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12. Click Config Space to read details about the PCle configuration space. Figure 72 shows the
PCle configuration space.

.
< PCle Demo Ver 11.8 [ =] ﬂ
= -
_ Microsemi PCle Demo
Tue, Mar 25, 2014 1:50:05 PM Link width: | 4x | Gen| 2 | Rate| 56 | Board|SF2 Dev kit Bl
PCle Link Info Hame Data Description -
X AFEIN Ox11RR Vendor ID
— 2_ DID Oxl11AR Device ID
Dema Controls 3. am 0x406 Command
4. S5TS 0x10 Status
5. RID CLCD 0x0 Revision ID & Class Code
- " 8. SCC 0x0 Sub Class Code
Config Space R ol eiienad 0x0 Base Class Code
8. CALN 0x10 Cache Line Size =
9. LAT Ox0 Latency Timer
PCle R/W 10. HDR 0x0 Header Type
1i_:BIST Ox0 Built-imnSelf Test
1Z. BLDDRO OxF7C00000 Bage hddress 0
13. BADDR1 OxF7D00000 Base Address)l
14_. BADDRZ 0x0 Base Address 2
15. BADDR3 Ox0 Base Address 3
16. BADDR4 0x0 Base Address 4 B
17. BADDRS 0x0 Base Address 5
1B. CIS 00 CardBus €I5 Pointer
I8 SWIN Oxl1l22 Sub-system Vendor/ ID
20. SDID Ox0 Sub-system Device ID
l 21 . EROM 0x0 Expansion ROM Base Address -
r )
® N SuarTFusion 2
{ 5 =
PCle Link
<

Figure 72 + Configuration Space

13. Click PCle R/W to perform read and writes to eSRAM memory through BAR1 space. Figure 73
shows the PCle'R/W window.
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14. Enter the address in the Address field between 0x0000 to OXFFFC. The Data field accepts a 32-
bit hexadecimal value.

L] )

-
L PCle Demo Ver 11.8

< Microsemi PCIe Demio

Tue, Mar 25, 2014 1:50:31 PM Link Width: | 4x | Gen| 2 Rate| 5G | Board | SF2 DevKit [=] L‘_ﬁ
+ ,

BAR 1 Memory Range

Address HZ4U

Data {l FoFoFoFo

Read ] Write ]

@® . 4 SuarTFusion 2

PCle Link

Figure 73 * Perform Read and Write to eSRAM Using PCle
15. Click Exit to quit the demo.
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Running the Demo Design on Linux
1. Switch ON the Red Hat Linux Host PC.
2. Red Hat Linux Kernel detects the SmartFusion2 PCle end point as Actel Device.
3. On Linux Command Prompt Use 1spci command to display the PCle info.
# lspci

(] Applications Places System %@Q@ 3:36 PM @J})
TS e

root@localhost:~

File Edit View Terminal Tabs Help

[root@localhost ~]# lspci
00:00.0 Host bridge: Intel Corporation 4 Series Chipset DRAM Controller (rev 03)

00:01.0 PCI bridge: Intel Corporation 4 5Series Chipset PCI Express Root Port (rev 03)
00:02.0 VGA compatible controller: Intel Corporation 4 Series Chipset Integrated Graphics Controller (rev 03)
080:82.1 Display controller: Intel Corporation 4 Series Chipset Integrated Graphics Controller (rev 03)
00:1b.0 Audio device: Intel Corporation N1O/ICH 7 Family High Definition Audio Controller (rev 81)
00:1c.® PCI bridge: Intel Corporation N1@/ICH 7 Family PCI Express Port 1 (rev 81)
00:1d.® USB controller: Intel Corporation N1®/ICH 7 Family USB UHCI Controller #1 (rev 81)
00:1d.1 USB controller: Intel Corporation N18/ICH 7 Family USB UHCI Controller #2 (rev 01)
00:1d.2 USB controller: Intel Corporation N18/ICH 7 Family USB UHCI Controller #3 {rev 01)
08:1d.3 USB controller: Intel Corporation N18/ICH 7 Family U5SE UHCI Controller #4 (rew 01)
00:1d.7 USE controller: Intel Corporation N1O/ICH 7 Family US5SB2 EHCI Controller (rev @1)
00:1e.0 PCI bridge: Intel Corporation 82801 PCI Bridge (rev el)
0O:17.0 ISA bridge: Intel Corporation 82801GB/GR (ICH7 Family) LPC Interface Bridge (rev 01)
08:1f.1 IDE interface: Intel Corporation 82801G (ICH7 Family) IDE Controller (rev 81)
.2

orporation Netlink BCM57780 Gigabit Ethernet PCIe (rev 01)

[ root@localhost:~ ][ @ Starting Take Screenshot I @

Figure 74 « PCle Device Detection

Drivers Installation
Enter the following commands in the Linux command prompt to install the PCle drivers:
1. Create the sf2 directory under the home/ directory using the following command:
# mkdir /home/sf2

2. Copy the_ M2S_PCIE_Control_DEMO_DF\Linux_64bit\Drivers\PCle_Driver folder from the
Windows host PC and place it into the /home/sf2 directory of RedHat Linux host PC.

3. Copy the M2S_PCIEControl_DEMO_DF\Linux_64bit\Drivers\inc folder from the Windows host
PC and place it into the /home/sf2 directory of RedHat Linux host PC.

The /home/sf2 directory must contain PCle_Driver/ inc/ folders.

4. Execute 1s.command to display the contents of /home/sf2 directory.
# 1s

5. Change to inc/ directory by using the following command:
#¢d /home/sf2/inc
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6. Edit the board.h file for SmartFusion2 Development Kit as shown in Figure 75.
#vi board.h
#define SF2
#undef IGL2

] Applications Places System %@@g@ 7:15 PM @J})

root@localhost:/home/sf2/inc

Fle Edit View Jerminal Tabs Help

e

* SF2 : SmartFusion2 Board, IGL2: IGLOO2 Board

* #define SF2, if the hardware board is SmartFusion2
* #define IGL2, if the hardware board is IGLOOZ

=

#define SF2

#undef IGL2

[ R e e e

=

=

[ ]
I

@ [ root@localheost:/nome/sr2/inc ]

Figure 75 + Edit board.h File

7. To save the selected file, execute the :wg command
8. Change to PCle_Driver/ directory using thé ed command:
#cd /home/sf2/PCIe Driver
9. To compile the Linux PCle device driver code, execute make command.

#make clean [To clean.any *.o0, *.ko files]

#make
10. The kernel module, pci chr drv ctrlpln.ko creates in the same directory.
11. To insert the Linux PCle device driver as a module, execute insmod command.
#insmod pci chx _dr¥ ctrlpln.ko

Note: Root privileges are required to execute this command.
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] Applications Places System %@Q@ 7:17 PM @m

root@localhost:/home/sf2/PCle_Driver

Fle Edit Miew Jerminal Tabs Help

[root@localhost PCIe Driver]# pwd
/home/sT2/PCIe_Driver
[root@localhost PCIe _Driver]# 1s
Makefile pci chr drv ctripln.c
[root@localhost PCIe_Driver]#
make -C /lib/modules/2.6.18-308.€l5/build SUBDIRS=/home/sT2/PCIe_Driver modules
make[1]: Entering directory ~/usr/src/kernels/2.6.18-308.e15-x86 64"
CC [M] /home/sf2/PCIe_Driver/pci_chr_drv_ctrlpln.o
Building modules, stage 2.

MODPOST

cc /home/sf2/PCIle_Driver/pci_chr_drv_ctripln.mod.o

LD [M] /home/sf2/PCIe_Driver/pci_chr_drv_ctripln.ko
make[1l]: Leaving directory "/fusr/src/kernels/2.6.18-388.el5-x86 64"
[root@localhost PCIe_Driver]# 1s
Makefile Module.symvers pci_chr_drv_ctripln.ko pci_chr_drv_ctripln.mod.o
Module.markers pci chr drv_ctplplo, c pci che deow cirloplp .c pci chr drv_ctripln.o
[root@localhost FCIe_Driver]#Ensmod pcichr dry ctripln.ko I

[root@localhost PCIe Driver]# 1s /dev/MS_PCI_DEV

/dev/MS_PCI_DE

[root@localhost PCIe Driver]# |:|

-

[;] [ root@localhest:/nome/sf2/PCle_Driver ] ®

Figure 76 * PCle Device Driver Installation

12. After successful Linux PCle device driver installation, check /dev/MS PCI DEV got created by

Note:

using the following Linux command:
#1s/dev/MS_PCI DEV

/dev/MS_PCI_ DEV interface is used to access the SmartFusion2 PCle end point from Linux user
space.

Linux PCle Application Compilation and PCle Control Plane Utility

Creation

1. Change to the /home/sf2/ directory using the following command:
#cd /home/sf2

2. Copy the "M2S_PCIE_Control_DEMO_DF\Linux_64bit\Uti\PCle_App folder from the Windows
host PC and place it into the /home/sf2 directory of RedHat Linux host PC.

3. Change to the /home/sf2/PCle_App directory using the following command:
#cd /home/sf2/PCIe App

4. Compile the'Linux user space application pcie appln ctrlpln.c by using gcc command.

#gcc -o pcie ctrlplane pcie appln ctrlpln.c
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.Applicatmns Places System %@%g@
=

root@localhost:/home/sf2/PCle_App

Fle Edit Miew Jerminal Tabs Help

[root@localhost PCIe Appl# pwd

/home/sf2/PCIe_App

[root@localhost PCIe_Appl# ls

led blink.sh pcie appln C ol il i i el

[root@localhost FCIe_App]#Igcc -0 pcie_ctrlplane pcie_appln_c‘trlpln.cl
[root@localhost PCIe_Appl# (3

led blink.sh pcie appln_c plo podie copfig.sh pcie ctrliplane
[root@localhost PCIe_Appl#|./pcie ctriplane

Description: LED Control [1], Led Data [0x0-8xB80080FF]
Example: ./pcie_ctriplane 1 G8x0B80BBFF

Description: SRAM WRITE [2], Write[1], SRAM Data [Bx@-0xFFFFFFFF], SRAM Offset[0x0-8x3FFF]
Example: ./pcie_ctriplane 2 1 0x12345678 0x10

Description: SRAM READ [3],Read[@], SRAM Offset[0x8-0x3FFF]
Example: ./pcie ctriplane 3 0@ oxle

Description: Dip Switch Status [4]
Example: ./pcie ctriplane 4

Description: PCIe Device Info [5], Display PCIe Configuration Space/PCIle Device Detailed Info[l/2]

Example: ./pcie ctriplane 5 1

Description: PCIe Interrupt Control [B], Enable/(Clear/Disable)[1/0]
Example: ./pcie ctriplane 6 1

Description: PCIe Interrupt Count [7]
Example: ./pcie ctriplane 7

[root@localhost PCIe_Appl# [l

3:50 PM Q)
——=

[+)

[#@]-[ 18 root@iocainost mome/sr2PCie_app | [33 PCle_Detection’ | @)save Screenshot | @@ Starting Take Screenshot_|

Figure 77 » Linux PCle Application Utility

5. After successful compilation; Linux PCle application utility pcie ctrlplane creates in the same

directory.

6. On Linux Command Prompt run the pcie ctrlplane utility as:
#./pcie ctrlplane

7. Help menu displays as shown in Figure 77.

Revision 3

73



& Microsemi

SmartFusion2 SoC FPGA - PCle Control Plane Demo

Execution of Linux PCle Control Plane Features

LED Control

LED1 to LEDS is controlled by writing data to SmartFusion2 LED Control Registers.
#./pcie ctrlplane 1 0x000000FF [LED ON]
#./pcie _ctrlplane 1 0x00000000 [LED OFF]

@) Applications  Places System @@@@
(%

root@localhost:/home/sf2/PCle_App
File Edit View Terminal Tabs Help
[root@localhost PCIe Appl# ./pcie_ctriplane

Description: LED Control [1], Led Data [8x8-0x80880GFF]
Example: ./pcie_ctriplane 1 ©x000BOOFF

Description: SRAM_WRITE [2], Write[1], SRAM Data [0x8-8xFFFFFFFF], SRAM Offset[0x8-0x3FFF]
Example: ./pcie_ctriplane 2 1 0x12345678 0x10

Description: SRAM _READ [3],Read[@], SRAM Offset[8x0-0x3FFF]
Example: ./pcie_ctrlplane 3 0 0x10

Description: Dip Switch Status [4]
Example: ./pcie_ctriplane 4

Description: PCIe Device Info [3], Display PCIe Configuration Space/PCIe Device Detailed Info[l1/2]
Example: ./pcie_ctriplane 5 1

Description: PCIe Interrupt Control [6], Enmable/(Clear/Disable)[1/0]
Example: ./pcie_ctriplane 6 1

Description: PCIe Interrupt Count [7]
Example: ./pcie_ctriplane 7

[root@localhost PCIe Appl# ./pcie_ctriplane 1 @xB88GBOFF
[root@localhost PCIe Appl# ./pcie_ctrlplane 1 9x00090800
[root@localhost PCIe Appl# I

350 PM Q)
BoE

D)

E] [ root@localhost:/home/sf2/PCle_App ]I PCle_Detection* [. Save 5creenshot ]I @@ Starting Take Screenshot

Figure 78 * Linux Command - LED Control

led blink.sh, contains the shell script code to perform LED Walk ON where as Ctrl C exits the

shell_script and LED Walk turns OFF.
Run theded_blink.sh shell script using sh command.
#sh ledyblink.sh
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SRAM Read/Write

64 KB SRAM is accessible for SmartFusion2 Development Kit.
#./pcie_ctrlplane 2 1 OxFFOOFFOO 0x1000 [SRAM WRITE]
#./pcie ctrlplane 3 0 0x1000 [SRAM READ]

] Applications Places System %@%g@ 3:52PM @m

root@localhost:/home/sf2/PCle_App

Fle Edit Miew Jerminal Tabs Help
[root@localhost PCIe Appl# ./pcie ctriplane

D)

Description: LED Control [1], Led Data [0x0-0x000000FF]
Example: ./pcie ctrilplane 1 8x000080FF

Description: SRAM WRITE [2], Write[l], SRAM Data [0x0-8xFFFFFFFF], SRAM OfTset[8x0-0x3FFF]
Example: ./pcie ctriplane 2 1 8x12345678 0x18

Description: SRAM_READ [3],Read[@], SRAM Offset[0x@-0x3FFF]
Example: ./pcie ctriplane 3 8 8x10

Description: Dip Switch Status [4]
Example: ./pcie ctriplane 4

Description: PCIe Device Info [5], Display PCIe Configuration Space/PCIe Device Detailed Info[l/2]
Example: ./pcie ctriplane 5 1

Description: PCIe Interrupt Control [6], Enable/(Clear/Disable)[1/0]
Example: ./pcie ctriplane 6 1

Description: PCIe Interrupt Count [7]
Example: ./pcie ctrilplane 7

[root@localhost PCIe Appl# ./pcie ctriplane 2 1 0x12345678 0x10080
[root@localhost PCIe Appl# ./pcie ctriplane 3 8 0x1080

SF2 SRAM data Read : ©0x12345678

[root@localhost PCIe_Appl# [l

@ [ roct@localhost:/home/sf2/PCle_App ][ & PclerDetection' H @ Save Screenshot [- Starting Take Screenshot ]i =]

Figure 79 * Linux Command - SRAM Read/Write
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DIP Switch Status

Dip Switch on SmartFusion2 Development Kit consists of 4 electric switches to hold the device
configurations. Linux PCle utility reads the corresponding switches (ON/OFF) state.

#./pcie _ctrlplane 4 [DIP Switch Status]

@ Applications Places System %@@g@
o |

root@localhost:/home/sf2/PCle_App
Fle Edit View Terminal Tabs Help
[root@localhost PCLe Appl# ./pcie_ctrlplane

Description: LED Control [1], Led Data [0x0-8xB080008FF]
Example: ./pcie_ctriplane 1 0x808888FF

Description: SRAM WRITE [2], Write[1], SRAM Data [8x0-OxFFFFFFFF], SRAM Offset[0x0-0x3FFF]
Example: ./pcie_ctriplane 2 1 8x12345678 0x10

Description: SRAM READ [3],Read[8], SRAM Offset[0x8-0x3FFF]
Example: ./pcie_ctriplane 3 0 @x1@

Description: Dip Switch Status [4]
Example: ./pcie_ctriplane 4

Description: PCIe Device Info [5], Display PCIe Configuration Space/PCIe Device Detailed Info[1l/2]
Example: ./pcie_ctriplane 5 1

Description: PCIe Interrupt Control [6], Enable/{Clear/Disable)[1/0]
Example: ./pcie_ctriplane 6 1

Description: PCIe Interrupt Count [7]
Example: ./pcie_ctriplane 7

[root@localhost PCIe Appl# ./pcie ctriplane 4
DIP Switch Data Register Value : 8x1800

SW1 : ON
SW2 : ON
SW3 : ON
SW4 : ON

[root@localhost PCIe Appl# I

3:53pM Q)

@|-[ B root@localnost /nome/sr2/FCle_App | |5 PCIE Detection’,, | @@ Save Screenshot | @ Starting Take Screenshot

Figure 80 * Linux Command - DIP Switch
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PCle Configuration Space Display

PCle Configuration Space contains the PCle device data, such as Vendor ID, Device ID, Base Address
0.

Note: Root Privileges are required to execute this command.
#./pcie _ctrlplane 5 1 [Read PCIe Configuration Space]

] Applications Places System %@@g@ 3:53 PM @J»
B X

root@localhost:/home/srZ/PCI

Fle Edit View Jerminal Tabs Help
[root@localhost PCIe Appl# ./pcie ctriplane

[*]

Description: LED Control [1], Led Data [0x0-0x000000FF]
Example: ./pcie ctriplane 1 8x000080FF

Description: SRAM WRITE [2], Write[l], SRAM Data [0x0-8xFFFFFFFF], SRAM Offset[0x0-0x3FFF]
Example: ./pcie ctriplane 2 1 8x12345678 0x18

Description: SRAM_READ [3],Read[@], SRAM Offset[0x@-0x3FFF]
Example: ./pcie ctriplane 3 8 8x10

Description: Dip Switch Status [4]
Example: ./pcie ctriplane 4

Description: PCIe Device Info [5], Display PCIe Configuration Space/PCIe Device Detailed Info[l/2]
Example: ./pcie ctriplane 5 1

Description: PCIe Interrupt Control [6], Enable/(Clear/Disable)[1/0]
Example: ./pcie ctriplane 6 1

Description: PCIe Interrupt Count [7]
Example: ./pcie ctrilplane 7

[root@localhost PCIe_Appl# ./pcie_ctriplane 5 1

Name Data Description
1.VID Oxllaa Vendor Id
2.DID Bx1laa Device ID
3.CMD 0x8406 Command
4.5T5 0x0018 Status
5.RID CLCD Gx08608 Revision ID & Class Code
6.5CC 0xee Sub Class Code
7.BCC 0xee Base Class Code
8.CALN Bx10 Cache Line Size
9.LAT 0xee Latency Timer
10. HDR 0x00 Header Type
11.BIST Bx86 Built-in Self Test

12.BADDRE 0OxTe500000 Base Adress @
13.BADDR1 0Oxfed4foO0@ Base Adress 1
14.BADDRZ 0x00000008 Base Adress 2
.BADDR3 0©xB0000000 Base Adress 3
4
5

15

16.BADDR4 0x00000000 Base Adress

17.BADDR5 Bx00008000 Base Adress

18.CIs 0x00080080 CardBus CIS Pointer

19.5VID Oxllaa Sub-system Vendor ID

20.5DID Bx0608 Sub-System Device ID

21.EROM 0x00080080 Expansion ROM Base Address
22.NEW_CAP 0x50 New Capabilities Pointer —
23.INTLN Bx8b Interrupt Line

24.INTPIN ©x81 Interrupt Fin

25.MINGNT. 0x80 Minimum' Regquired Burst Period
26 .MAXLAT 0Gx080 Maximum Latency

[root@localhost PCIe_Appl# [l

[ & rost@localhost fhome/sr2/PCle_app | [ PCle_Detection' | @ Save Screenshot || @@ Starting Take Screenshot

Figure 81 » Linux Command - PCle Configuration Space Display
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PCle Link Speed and Width
Note: Root Privileges are required to execute this command.
#./pcie ctrlplane 5 2 [Read PCIe Link Speed and Link Width]

@) Applications Places System %@@@@
=

root@localhost:/home/sf2/PCle_App
File Edit Wiew Terminal Tabs Help
[root@localhost PCIe_Appl# ./pcie_ctriplane

Description: LED Control [1], Led Data [x0-8x800800FF]
Example: ./pcie_ctriplane 1 0x000000FF

Description: SRAM_WRITE [2], Write[1], SRAM Data [@x@-8xFFFFFFFF], SRAM Offset[Bx0-Ox3FFF]
Example: ./pcie_ctriplane 2 1 0x12345678 0x10

Description: SRAM_READ [3],Read[@], SRAM OTfset[0x@-0x3FFF]
Example: ./pcie ctriplane 3 8 0x18

Description: Dip Switch Status [4]
Example: ./pcie_ctriplane 4

Description: PCIe Device Info [5], Display PCIe Configuration Space/PCIe Device Detailed Info[l/2]
Example: ./pcie ctriplane 5 1

Description: PCIe Interrupt Control [B], Enable/(Clear/Disable)[1/0]
Example: ./pcie ctriplane 6 1

Description: PCIe Interrupt Count [7]
Example: ./pcie_ctriplane 7

[root@localhost PCIe_Appl# ./pcie_ctriplane 5 2fi

3.54 P Q)

D)

‘@|-[ B root@localhost ihome/sr2/PCle_App || [ PCle_Detection’ _ |[# saveSereenshot || @ starting Take Screenshot

Figure 82 * Linux Command - PCle Link Speed and Width
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Applications Places System %@%g@ 3:54 PM @J})

root@localhost:/fhome/sf2/PCle_App

Fle Edit Miew Jerminal Tabs Help

[+)

Kernel driver in use: 1801 smbus
Kernel modules: i2c-ig@1

081:00.0 Non-VGA unclassified device: Actel Device 1llaa
subsystem: Actel Device 0000
Control: I/0- Mem+ BusMaster+ SpecCycle- MemWINY- VGASnoop- ParErr- Stepping- SERR- FastB2B- DisINTx+
Status: Cap+ 66MHz- UDF- FastB2B- ParErr- DEVSEL=fast =TAbort- <TAbort- <MAbort- =5ERR- <PERR- INTx-
Latency: @, Cache Line Size: 64 bytes
Interrupt: pin A routed to IRQ 74
Region @: Memory at fe580080@ (32-bit, non-prefetchable) [size=1M]
Region 1: Memory at fed4f0O80 (32-bit, non-prefetchable) [size=64K]
Capabilities: [58] MSI: Enable+ Count=1/1 Maskable- 64bit+
Address: 00080000TeefB000 Data: 404a
Capabilities: [78] Power Management version 3
Flags: PMEClk- DSI- D1- D2- AuxCurrent=0mA PME(DO+,D1l-,D2-,D3hot+,D3cold-)
Status: DO NoSofTtRst+ PME-Enable- DSel=8 D5cale=0 PME-
Capabilities: [80] Express (v2) Endpoint, MS5I 01
DevCap: MaxPayload 256 bytes, PhantFunc 8, Latency L®s unlimited, L1 unlimited
ExtTag+ AttnBtn- AttnInd- PwrInd- RBE+ FLReset-
DevCtl: Report errors: Correctable- Non-Fatal+ Fatal+ Unsupported-
RlxdOrd+ ExtTag+ PhantFunc- AuxPwr- NoSnoop+
MaxPayload 128 bytes, MaxReadReg 512 bytes
DevSta: CorrErr- UncorrErr- FatalErr- UnsuppReq- AuxPwr- TransPend-
LnkCap: Port #1, Speed 5GT/s, Width x4, ASPM LOs L1, Latency L@ <64ns, L1 <16us
ClockPM+ Surprise- LLActRep- BwNot-
LnkCtl: ASPM Disabled; RCE 64 bytes Disabled- Retrain- CommClk+

Bt {4 I ol el S jdDis- BWINnt- AutBWInt-
LnkSt. Speed 2.5GT/s, Width x4, JTrErr- Train- S5lotClk+ DLActive- BWMgmt- ABWMgmt-
e ABCD, TimeoutDis-

DevCtl2: Completion Timeout: 50us to 50ms, TimeoutDis-
LnkCt12: Target Link Speed: 5GT/s, EnterCompliance- SpeedDis-, Selectable De-emphasis: -6dB
Transmit Margin: Normal Operating Range, EnterModifiedCompliance- ComplianceS0s-
Compliance De-emphasis: -6dB
LnkSta2: Current De-emphasis Level: -3.5dB
Capabilities: [100 v1] WVirtual Channel
Caps: LPEVC=0 RefClk=180ns PATEntryBits=1
Arb: Fixed- WRR32- WRR64- WRR128-
ctri: Arbselect=Fixed
Status: InProgress-
vee: Caps: PATOffset=00 MaxTimeSlots=1 RejSnoopTrans-
Arb: Fixed- WRR32- WRRG64- WRR128- TWRR128- WRR256-
ctri: Enable+ ID=08 ArbSelect=Fixed TC/VC=01
Status: NegoPending- InProgress-
Capabilities: [8088 v1] Advanced Error Reporting
UESta: DLP- SDES- TLP- FCP- CmpltTO- CmpltAbrt- UnxCmplt- RxOF- MalfTLP- ECRC- UnsupReg- ACSViol-
UEMsk: DLP- SDES- TLP- FCP- CmpltTO- CmpltAbrit- UnxCmplt- RxOF- MalfTLP- ECRC- UnsupReqg- ACSViol-
UESwrt: DLP+ SDES+ TLP- FCP+ CmpltTO- CmpltAbrt- UnxCmplt- RxOF+ MalfTLP+ ECRC- UnsupReg- ACSViol-
CESta: RxErr- BadTLP- BadDLLP- Rollover- Timeout- NonFatalErr- |
CEMsk: RxErr- BadTLP- BadDLLP- Rollower- Timeout- NonFatalErr+
AERCap: First Error Pointer: 08, GenCap+ CGenEm- ChkCap+ ChKEn-
Kernel driver in use: M5_PCI_DRIVER

02:00.0 Ethernet controller: Broadcom Corporation NetLink BCM57780 Gigabit Ethernet PCIe (rev 1)
Subsystem: Dell Device 0400

C0<|

@ [ root@localhost: /home/sf2/PCle_App H [&F PCle_Detection' |[ @ Save Screenshot H @ Starting Take Screenshot

Figure 83 * Linux Command - PCle Link Speed and Width
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PCle Interrupt Control (Enable/Disable) and Interrupt Counter
SmartFusion2 Development Kit enable/disable the MSI interrupts by writing data to its PCle configuration
space.
Interrupt Counter holds the number of MSI interrupts got triggered by pressing the SW3 Push Button.
#. /pcie ctrlplane 6 0 [Disable Interrupts]
#. /pcie ctrlplane 6 1 [Enable Interrupts]

#. /pcie ctrlplane 7 [Interrupt Counter Value]

Fle Edit Miew Jerminal Tabs Help

[root@localhost PCIe Appl# ./pcie ctriplane

Description: LED Control [1], Led Data [0x0-0x000000FF]

QApplicatmns Places System %@Q@
=

Example: ./pcie ctriplane 1 8x000080FF

Description: SRAM WRITE [2], Write[l], SRAM Data [0x0-8xFFFFFFFF], SRAM 0fTset[8x0-0x3FFF]
Example: ./pcie ctriplane 2 1 8x12345678 0x18

root@localhost:/home/sf2/PCle_App

Description: SRAM_READ [3],Read[@], SRAM Offset[0x@-0x3FFF]
Example: ./pcie ctriplane 3 8 8x10

Description: Dip Switch Status [4]

Example: ./pcie ctriplane 4

Description: PCIe Device Info [5], Display PCIe Configuration Space/PCIe Device Detailed Info[l/2]

Example: ./pcie ctriplane 5 1

Description: PCIe Interrupt Control [6], Enable/(Clear/Disable)[1/0]

Example: ./pcie ctriplane 6 1

Description: PCIe Interrupt Count
Example: ./pcie ctrilplane 7

[root@localhost PCIe_Appl# ./pcie
[root@localhost PCIe Appl# ./pcie ¢
SF2 PCIe Interrupt Counter Value :
[root@localhost PCIe_Appl# ./pcie
SF2 PCIe Interrupt Counter Value :
[root@localhost PCIe Appl# ./pcie_
[root@localhost PCIe_Appl# ./pcie
SF2 PCIe Interrupt Counter Value :
[root@localhost PCIe Appl# ./pcie_
SF2 PCIe Interrupt Counter Value :

[root@localhost PCIe Appl# I
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3:54 P )

[»

‘@B root@localngst nome/sr2/PCle App | & PCle_Detection’ | @ Save Screenshot || @ Starting Take Screenshot

Figure 84 * Linux Command - PCle Interrupt Control

Conclusion

This'demo describes how to access the PCle endpoint features of SmartFusion2 and how to create a
simple design and verify the design using BFM simulation. This demo demonstrates that the Host PC
can easily communicate with SmartFusion2 Development Kit through the provided GUI and Drivers. This
demo also provides a Linux PCle application for accessing PCle EP device through Linux PCle Device

Driver.
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A — List of Changes

The following table lists the critical changes that were made in each revision of the chapter in the demo

guide.
Date Changes Page
Revision 3 Updated the document for Libero v11.4 software release (SAR 59644). NA
(August 2014)
Revision 2 Updated the document for Libero v11.3 software release (SAR 56081). NA
(April 2014)
Revision 1 Updated the document for Libero v11.2 software release (SAR 52109)(SAR 52909) NA
(December 2013) and (SAR 50779).
Revision 0 Initial Release NA

(June 2013)
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B — Product Support

Microsemi SoC Products Group backs its products with various support services, including Customer
Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices.
This appendix contains information about contacting Microsemi SoC Products Group and using these
support services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

From North America, call 800.262.1060
From the rest of the world, call 650.318.4460
Fax, from anywhere in the world, 408.643.6913

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled
engineers who can help answer your hardware, software, and design questions about Microsemi SoC
Products. The Customer Technical Support Center spends a great deal of time creating application
notes, answers to common design cycle questions, documentation of known issues, and various FAQs.
So, before you contact us, please visit our online resources. lt'is very likely we have already answered
your questions.

Technical Support

Visit the Customer Support website (www.microsemi.com/soc/support/search/default.aspx) for more
information and support. Many answers available on the searchable web resource include diagrams,
illustrations, and links to other resources on the website.

Website

You can browse a variety of technical and non-technical information on the SoC home page, at
Www.microsemi.com/soc.

Contacting the Customer Technical Support Center

Highly skilled engineers staff the Technical Support Center. The Technical Support Center can be
contacted by email or through the Microsemi SoC Products Group website.

Email

You can communicate your technical questions to our email address and receive answers back by email,
fax, or phone. Also, if you have design problems, you can email your design files to receive assistance.
We constantly monitor the email account throughout the day. When sending your request to us, please
be sure to include your full name, company name, and your contact information for efficient processing of
your request.

The technical support email address is soc_tech@microsemi.com.
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My Cases

Microsemi SoC Products Group customers may submit and track technical cases online by going to My
Cases.

Outside the U.S.

Customers needing assistance outside the US time zones can either contact technical support via email
(soc_tech@microsemi.com) or contact a local sales office. Sales office listings can be found at
www.microsemi.com/soc/company/contact/default.aspx.

ITAR Technical Support

For technical support on RH and RT FPGAs that are regulated by International Traffic in Arms
Regulations (ITAR), contact us via soc_tech_itar@microsemi.com. Alternatively, within My Cases, select
Yes in the ITAR drop-down list. For a complete list of ITAR-regulated Microsemi FPGAs, visitthe ITAR

web page.
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Microsemi.

Microsemi Corporate Headquarters

One Enterprise, Aliso Viejo CA 92656 USA
Within the USA: +1 (800) 713-4113
Outside the USA: +1 (949) 380-6100
Sales: +1 (949) 380-6136

Fax: +1 (949) 215-4996

E-mail: sales.support@microsemi.com

Microsemi Corporation (Nasdaq: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for communications, defense and security, aerospace, and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs, and ASICs; power management products; timing and
synchronization devices and precise time solutions, setting the world's standard for time; voice
processing devices; RF solutions; discrete components; security technologies and scalable
anti-tamper products; Power-over-Ethernet ICs and midspans; as well as custom design
capabilities and services. Microsemi is headquartered in Aliso Viejo, Calif. and has
approximately 3,400 employees globally. Learn more at www.microsemi.com.

© 2014 Microsemi Corporation. All rights reserved. Microsemi and the Microsemi logo are trademarks of
Microsemi Corporation. All other trademarks and service marks are the property of their respective owners.
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